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Introduction 

This Programming Manual contains information on remote control over Planar 
TR1300/1, TR5048 or TR7530 Vector Network Analyzer (Analyzer) and its data 
communication by means of user programs written with COM/DCOM technology. 

COM technology is used when a user program runs together with an external 
measurement instrument program on one PC. DCOM technology is used when a user 
program runs on a PC connected with the measurement instrument by LAN. 

Methods and techniques for writing of user programs are same for the both 
technologies. The only difference between the technologies is that the DCOM 
technology requires additional LAN setting performed by the LAN administrator. 

Before reading this Manual, familiarize yourself with Analyzer Operating Manual. 

1 Registering COM Server 

To register COM server of the analyzer run the executable module from command 
prompt with the /regserver keyword. To unregister COM server of the analyzer run the 
executable module from command prompt with the /unregserver keyword. 
Administrative rights is required to register/unregister COM server. Also user has 
ability to register COM server during the software installation procedure.  

Example of  the COM server registration command: 

PlanarTR1300.exe /regserver 

TR5048.exe /regserver 

TR7530.exe /regserver 

2 COM Technology Overview 

COM stands for Component Object Model. This programming technology was 
developed by Microsoft for two purposes: 

 

 the model provides the specification for interaction of binary 
modules created in different programming languages; 

 the model defines the interfacing between a client application and a 
server application running either on the same PC or on two different 
PCs. In the latter case, the technology has DCOM abbreviation – 
Distributed COM.  
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3 Automation Server 

The network analyzer executable module contains a built-in COM server that enables 
other programs to access its functionality. The COM server was developed in 
conformity with the COM automation specification. COM automation is a technology 
allowing control over the COM server by the programs written in both traditional 
compiling programming languages and interpreting programming languages, such as 
VBScript. This enables the server applications to make their functionality accessible to 
many more clients. 

4 Automation Controllers 

Automation controllers are client programs, which use internal functionality of COM 
servers. Automation controller programs are developed by users for writing their own 
add-ons for the system. 

User programs can be written in different languages:  

 programming languages with built-in COM support, such as Visual 
Basic®, Delphi, Java; 

 universal programming languages, such as C, C++; 

 Microsoft Excel and Word office applications as they include built-in 
programming language Visual Basic for Applications®; 

 program generators, such as National Instruments LabView®, or 
HP–VEE.  

Examples represented in this Manual are written in Visual Basic (VB). Appendix 3 
contains examples written in VB, and C++ languages.  

Examples\COM\VBA folder contains source codes for examples written in Visual Basic 
for Applications® (Microsoft Excel files). 

Examples\COM\CPP folder contains source codes for the C++ language examples. 

5 Local and Remote Server 

The network analyzer executable module can function either as a local server or as a 
remote server of COM automation. 

Local server runs on the same PC with the automation controller and each of the 
programs is executed as an individual application in a separate window. COM 
technology is used in this case (Figure 1). 

Remote server and the automation controller run on different PCs connected by LAN. 
DCOM (Distributed COM) technology is used in this case (Figure 2). When using 
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DCOM it is necessary to configure the local network by means of DCOM Windows 
tools.  

The same automation controller is used for the both COM and DCOM technology. 
Some changes to the user program may be required in operators, which establish 
connection with the server. Moreover, DCOM technology requires additional settings of 
the LAN performed by the LAN administrator. 

 

 

Figure 1. COM technology 
 
 

 

Figure 2. DCOM technology 

USB Ethernet
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6 Structure of COM Objects 

COM server contains several objects, which provide different functionality of the 
server. The COM objects of the network analyzer executable module are organized in a 
hierarchical structure. Figure 3 shows the main COM objects, which comprise the first 
three levels of the hierarchical structure of the COM server. COM objects provide 
various methods and properties, which allow access to the server functions; besides, 
they allow access to the objects of the lower levels, which are not shown in Figure 3. 

 

 

 

 

 

 

 

 

 

 
Figure 3. The structure of COM objects  

 

The Object Application is in the top of the hierarchy COM server. Access to the lower 
level objects is implemented via higher level objects. 

Application 
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Note 

 
The hierarchy of COM objects is organized in accordance with 
the standard and syntax of the SCPI programming language. 
Operators in SCPI have hierarchical chain structure, for 
example: 

CALCulate:PARameter:DEFine S11 

The same COM command written in VB programming 
language is as follows: 

app.SCPI.CALCulate.PARameter.DEFine = "S11" 

7 Accessing the Application Object 

To establish connection with the COM server application, create an object reference in 
the client program. In COM programming the object reference needs to be acquired 
preliminarily, to be used later to access the object functionality. To define an object in 
Visual Basic perform the following: 

1) Declare a variable as an object.  

2) Assign the object to this variable. 

To declare a variable, use Dim operator or other declaration statement (Public, Private 
or Static). The variables used for references should of the types Variant, Object, or a 
type of a specific object. For example, the following three operators declare app 
variable:  

 

Dim app  

Dim app as Object 

Dim app as TR1300.Application 

Dim app as TR5048.Application 

Dim app as TR7530.Application 

Use Set operator and CreateObject (ObjectName, HostName) function to assign a 
specific object to a variable.  

 

ObjectName Automation object name is always equal to “TR1300.Applcation”, 
“TR5048.Applcation” or  “TR7530.Applcation” 

HostName Network name of the PC hosting the COM server. This parameter is not 
specified in case of a local server. 
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For example, the following operators create Application object and assign it to app 
variable:  

 

Set app = CreateObject("TR5048.Applcation") 

Set app = CreateObject("TR5048.Applcation", "Network_Name") 

Set app = CreateObject("TR5048.Applcation", "192.168.10.10") 

 
Note 

 
The first form of the operator is used to create the reference to 
the local COM server, the second one is used to create the 
reference to the remote DCOM server. 

To allow access to the objects of a lower level of the hierarchy, these objects are 
specified after the reference to the higher level object and separated from it by a dot. For 
example:  

 

Dim SystObj 

Set SystObj = app.SCPI.SYSTem 

COM objects can have indices. For example, CALCulate, INITiate, SENSe, SOURce 
objects represent various aspects of the 4 measurement channels of the Analyzer. 
Therefore, it is necessary to write the channel index from 1 to 4 to acquire the data of 
these objects. For example:  

 

Set SensObj1 = app.SCPI.SENSe(1)  

Set SensObj2 = app.SCPI.SENSe(2) 

Visual Basic allows omitting of such indices; in this case the indices are considered as 
equal to 1. For example, the following VB operators are equivalent: 

 

Set SensObj = app.SCPI.SENSe(1) 

Set SensObj = app.SCPI.SENSe 
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8 Object Methods 

Objects have methods. Methods are actions that can be applied to objects. The object 
methods are specified after the object name and separated from it by a dot. 

The following example shows the PRESet method of SYSTem object. This method 
performs setting of the Analyzer to the preset condition: 

 

app.SCPI.SYSTem.PRESet 

9 Object Properties 

Along with methods, objects have properties. Properties are object characteristics that 
can be set or read out. The object properties are specified after the object name and 
separated from it by a dot.  

To modify an object characteristic, write the value of the corresponding property. To 
define an object characteristic, read out the value of its property. The following example 
show the setting of the POINts property of SWEep object, i.e. the number of sweep 
points: 
 

app.SCPI.SENSe.SWEp.POINts = 201 

 
Note 

 
Some object properties cannot be written, and some object 
properties cannot be read. In such cases, the properties are 
indicated as “read only” or “write only”. 
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10 Error Handling 

You can use different approaches to error handling in VB program: 

 check the value of  Err.Number variable after execution of VB 
operator, which contains the call to COM server object; 

 use On Error goto VB operator. 

These approaches are represented in the examples below. The following operator causes 
an error in VB program as "S13" value of the DEFine property is incorrect. 

app.SCPI.PARameter.DEFine = "S13" 

In the first example, the value of  the Err.Number variable is checked after execution of 
the VB operator, which contains the call to COM server object. On Error Resume Next 
directive instructs VB not to interrupt the program execution when the error is detected 
but to pass control to the next operator in natural order. 

Dim app 

Public Sub HandleError1() 

Set app = CreateObject("TR5048.Application") 

On Error Resume Next 

app.SCPI.PARameter.DEFine = "S13"  

If Err.Number <> 0 Then 

  Msg = "Error # " & Str(Err.Number) & " was generated by " &_ 

  Err.Source & Chr(13) & Err.Description 

  MsgBox Msg,,"Error" 

End If 

... 

End Sub 
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In the second example, On Error GoTo ErrHandler directive instructs VB to interrupt 
the program execution when the error is detected and to pass control to ErrHandler 
label.  

 

Dim app 

Public Sub HandleError2() 

Set app = CreateObject("TR5048.Applcation") 

On Error GoTo ErrHandler 

app.SCPI.PARameter.DEFine = "S13" 

... 

Exit Sub 

ErrHandler: 

  Msg = "Error # " & Str(Err.Number) & " was generated by " &_ 

  Err.Source & Chr(13) & Err.Description 

  MsgBox Msg,,"Error" 

End Sub 

 

11 COM Automation Data Types 

In COM automation, there are the following data types, which can be used for client-to-
server communication: 

 

Long 32-bit  signed integer, value range from –2147483648 to 2147483647 

  

Double 64-bit double-precision floating point,  value range from  
–1.79769313486232E308 to –4.94065645841247E–324 for negative 
values, and from 4.94065645841247E–324 to 1.79769313486232E308 
for positive values 

  

Boolean 16-bit integer, two values 0 – False, 1 – True 

  

String Variable-length string 

  

Variant Can be either a value of arbitrary type or an array of values of arbitrary 
type. In this case, the term “arbitrary type” means any allowed type of 
COM automation. A variable contains information about its type and 
array size (if it is an array). It is used for communication of data arrays 
between a client and a server.  
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12 Measurement Data Arrays 

Measurement data can be either complex values or real values. This depends on the 
format  selected by the user. For example, the data is real in logarithmic magnitude 
format and the data is complex in polar format.  

The measurement data is transferred in a Variant type variable, which represents an 
array of Double type. To transfer one complex measurement, two adjacent array cells 
are used. To transfer one real measurement two adjacent array cells are used as well but 
the second cell is always equal to 0. Thus, measurement data array size is a double 
number of the measurement points.  

 

 

Measurement 1 Measurement 2  Measurement N 

Real Imag Real Imag … Real Imag 

Figure 4. Array of complex measurements 

 

 

Measurement 1 Measurement 2  Measurement N 

Value 0 Value 0 … Value 0 

Figure 5. Array of real measurements 
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13 COM Server Commands 

NAME 

Object Type Property (read only) 

Data Type String 

Description 
Instrument information string. String format: manufacturer, model, serial 
number, number of firmware version and number of software version. 

Range up to 40 characters 

Syntax 
Dim ID As String 

ID = app.NAME 

Equivalent Softkeys None 
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Ready 

Object Type Property (read only) 

Data Type Boolean 

Description 

Ready state of the instrument. Reads out the True value after successful 
completion of the boot process (about 10 sec). The vector analyzer must be 
connected to PC by a USB cable. 

Syntax 
Dim State as Boolean 

State = app.Ready 

Equivalent Softkeys None 
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SCPI.ABORt 

Object Type Method 

Description 

Aborts the sweep. Switches trigger mode from Single to Hold, or from 
Continuous to waiting for a trigger. If the trigger source is set to Internal, 
starts a new sweep. 

Syntax app.SCPI.ABORt 

Equivalent Softkeys None 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 20 

SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).USER.
FILename 

Object Type Property (read/write) 

Data Type String 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt:  port number 1–2 (see Table 2 on page 21) 

Description 
De-embedding function file name (*.s2p). The file contains the circuit S–
parameters in Touchstone format. 

Range up to 256 characters 

Preset Value "" 

Syntax 

Dim File As String 

File =  

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).USER.FILename 

 

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).USER.FILename 

 = "network.s2p" 

Notes 
If the full path to the file is not specified, the \FixtureSim subdirectory of the 
main directory will be searched for the file. 

Equivalent Softkeys Analysis > Fixture Simulator > De–Embedding > S–parameters File 
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Table 1. Ch: Channel Number 

Data Type Long 

Description Channel number. 

Range from 1 to 4 

Out of Range An error occurs. Error code: 201. 

 

Table 2. Pt: Port Number 

Data Type Long 

Description Port number. 

Range from 1 to 2 

Out of Range An error occurs. Error code: 114. 
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SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe 

Object Type Property (read/write) 

Data Type Boolean 

 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt:  port number 1–2 (see Table 2 on page 21) 

Description The ON/OFF state of the e-embedding function. 

Allowable Values 
True:  De-embedding function ON 
False: De-embedding function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe 

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True 

Equivalent Softkeys Analysis > Fixture Simulator > De–Embedding > Port n 
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SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).USER.
FILename 

Object Type Property (read/write) 

Data Type String 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt:  port number 1–2 (see Table 2 on page 21) 

Description 
Embedding function file name (*.s2p). The file contains the circuit S–
parameters in Touchstone format. 

Range up to 256 characters 

Preset Value "" 

Syntax 

Dim File As String 

File =  

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).USER.FILename 

 

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).USER.FILename 

 = "network.s2p" 

Notes 
If the full path to the file is not specified, the \FixtureSim subdirectory of the 
main directory will be searched for the file. 

Equivalent Softkeys Analysis > Fixture Simulator > Embedding > User File 
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SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt:  port number 1–2 (see Table 2 on page 21) 

Description The ON/OFF state of the embedding function. 

Allowable Values 
True:  Embedding function ON 
False: Embedding function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe 

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True 

Equivalent Softkeys Analysis > Fixture Simulator > Embedding > Port n 
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SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R 

Object Type Property (read/write) 

Data Type Double 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt:  port number 1–2 (see Table 2 on page 21) 

Description The value of the impedance for port impedance conversion function. 

Range from 1e–6 to 1e6 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 50 

Unit Ω (Ohm) 

Syntax 

Dim Value As Double 

Value = 
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R 

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R = 75 

Equivalent Softkeys Analysis > Fixture Simulator > Port Z Conversion > Port n Z0 
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SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the port impedance conversion function. 

Allowable Values 
True:  Port Z conversion function ON 
False: Port Z conversion function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = 
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe 

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe = True 

Equivalent Softkeys Analysis > Fixture Simulator > Port Z Conversion > Port Z Conversion 
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SCPI.CALCulate(Ch).PARameter.COUNt 

Object Type Property (read/write) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The number of traces in the channel. 

Range from 1 to 8 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1 

Syntax 

Dim TraceNum As Long 

TraceNum = app.SCPI.CALCulate(Ch).PARameter.COUNt 

app.SCPI.CALCulate(Ch).PARameter.COUNt = 2 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).PARameter(Tr).DEFine 

Object Type Property (read/write) 

Data Type String 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description The measurement parameter of the trace. 

Allowable Values 

"S11" : S11 parameter  

"S21" : S21 parameter 

Out of Range An error occurs. Error code: 208. 

Preset Value 

Depends on the trace number. 

Tr 1, Tr 3, Tr 5, Tr 7:  "S11" 
Tr 2, Tr 4, Tr 6, Tr 8:  "S21" 

Syntax 

Dim Meas As String 

Meas = app.SCPI.CALCulate(Ch).PARameter(Tr).DEFine 

app.SCPI.CALCulate(Ch).PARameter(Tr).DEFine = "S11" 

Equivalent Softkeys Response > Measurement > S11 | S21 
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Table 3. Tr: Trace Number 

Data Type Long 

Description Trace number 

Range from 1 to 8 

Out of Range An error occurs. Error code: 202. 

Notes If the trace number is not specified, it is taken as equal to 1. 
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SCPI.CALCulate(Ch).PARameter(Tr).SELect 

Object Type Method 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Tr: trace number 1–8 (see Table 3 on page 29) 

Description Sets the active channel and trace. 

Syntax app.SCPI.CALCulate(Ch).PARameter(Tr).SELect 

Notes 

If the channel number is greater than the number of the channels displayed, 
an error occurs and the command is ignored. If the trace number is greater 
than the number of the traces displayed in the channel, an error occurs and 
the command is ignored. 

Equivalent Softkeys 
Channel > Active Channel 
Trace > Active Trace 
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SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion 

Object Type Property (read/write) 

Data Type String 

 Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The S–parameter conversion function type. 

Range 

"IMPedance" : Reflection or Transmission equivalent impedance 
according to the trace measurement parameter (S11 
or S21) 

"ADMittance" : Reflection or Transmission equivalent admittance 
according to the trace measurement parameter (S11 
or S21) 

"INVersion" : Inverse S–parameter 

"CONJugation"        : S–parameter conjugate 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 217. 

Preset Value "IMP" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion 

app.SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion = "INV" 

Equivalent Softkeys 
Analysis > Conversion > Function > Impedance Z | AdmittanceY | Inverse 1/S | 
Conjugation  
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SCPI.CALCulate(Ch).SELected.CONVersion.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the S-parameter conversion function. 

Allowable Values 
True:  S–parameter conversion function ON 
False: S–parameter conversion function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.CONVersion.STATe 

app.SCPI.CALCulate(Ch).SELected.CONVersion.STATe = True 

Equivalent Softkeys Analysis > Conversion > Conversion 
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SCPI.CALCulate(Ch).SELected.CORRection.EDELay.TIME 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The value of the electrical delay. 

Range from –10 to 10 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.CORRection.EDELay.TIME 

app.SCPI.CALCulate(Ch).SELected.CORRection.EDELay.TIME = 1e–9 

Equivalent Softkeys Scale > Electrical Delay 
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SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The value of the phase offset. 

Range from –360 to 360 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit ° (degree) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe 

app.SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe = 360 

Equivalent Softkeys Scale > Phase Offset 
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SCPI.CALCulate(Ch).SELected.DATA.FDATa 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The formatted data array. The array elements contain measurements in the 
current format, for example, in logarithmic magnitude format (Log Mag). 
Also, see section “Measurement Data Arrays” on page 19. 

The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  real number in rectangular format, real part in polar 
and Smith chart formats; 

Data(2n–1)  0 in rectangular format, imaginary part in polar and 
Smith chart formats. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.DATA.FDATa 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.DATA.FMEMory 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The formatted memory array. The array elements contain saved 
measurements  in the current format, for example, in logarithmic magnitude 
format (Log Mag). Also, see section “Measurement Data Arrays”. 

The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  real number in rectangular format, real part in polar 
and Smith chart formats; 

Data(2n–1)  0 in rectangular format, imaginary part in polar and 
Smith chart formats. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.DATA.FMEMory 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.DATA.SDATa 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The corrected data array. The corrected measurements are complex 
numbers. Also, see section “Measurement Data Arrays” on page 19. 

 The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)   the real part of corrected measurement; 

Data(2n–1)  the imaginary part of corrected measurement. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.DATA.SDATa 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.DATA.SMEMory 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The corrected memory array. The corrected measurements are complex 
numbers. Also, see section “Measurement Data Arrays” on page 19. 

The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  the real part of corrected measurement memory; 

Data(2n–1)  the imaginary part of corrected measurement memory. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.DATA.SMEMory 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The gate center value of the gating function. 

Range Varies depending on the frequency span and the number of points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer = 1e–8 

Equivalent Softkeys Analysis > Gating > Center 
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SHAPe 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The gate shape of the gating function. 

Range 

"MAXimum" : Maximum shape 

"WIDE" : Wide shape 

"NORMal" : Normal shape 

"MINimum" : Minimum shape 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 218. 

Preset Value "NORM" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SHAPe 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SHAPe = "MAX" 

Equivalent Softkeys Analysis > Gating > Shape > Maximum | Wide | Normal | Minimum  
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The gate span value of the gating function. 

Range Varies depending on the frequency span and the number of points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 2e–8 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN = 1e–8 

Equivalent Softkeys Analysis > Gating > Span 
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The gate start value of the gating function. 

Range Varies depending on the frequency span and the number of points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value –1e–8 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt = 1e–7 

Equivalent Softkeys Analysis > Gating > Start 
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the gating function. 

Allowable Values 
True:  Gating function ON 
False: Gating function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe = Status 

Equivalent Softkeys Analysis > Gating > Gating 
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The gate stop value of the gating function. 

Range Varies depending on the frequency span and the number of points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1e–8 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP = 1e–7 

Equivalent Softkeys Analysis > Gating > Stop 
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The gate type of the gating function. 

Range 

"BPASs" : Bandpass type 

"NOTCh" : Notch type 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 219. 

Preset Value "BPAS" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE 

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE = "NOTC" 

Equivalent Softkeys Analysis > Gating > Type 
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SCPI.CALCulate(Ch).SELected.FORMat 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Data format. 

Range 

"MLOGarithmic" : Logarithmic magnitude  
"PHASe" : Phase  
"GDELay" : Group delay time  
"SLINear" : Smith chart format (Lin) 
"SLOGarithmic" : Smith chart format (Log) 
"SCOMplex" : Smith chart format (Real/Imag) 
"SMITh" : Smith chart format (R + jX) 
"SADMittance" : Smith chart format (G + jB) 
"PLINear" : Polar format (Lin) 
"PLOGarithmic" : Polar format (Log) 
"POLar" : Polar format (Real/Imag) 
"MLINear" : Linear magnitude  
"SWR"  : Voltage standing wave ratio  
"REAL" : Real part  
"IMAGinary" : Imaginary part  
"UPHase" : Expanded phase 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 209. 

Preset Value "MLOG" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.FORMat 

app.SCPI.CALCulate(Ch).SELected.FORMat = "PHAS" 

Equivalent Softkeys 

Response > Format > Log Mag | SWR | Phase | Expand Phase | Group Delay | 
Lin Mag | Real | Imag  
 
Response > Format > Smith > Log / Phase | Lin / Phase | Real / Imag | R+jX | 
G+jB  
 
Response > Format > Polar > Log / Phase | Ling / Phase | Real / Imag  
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SCPI.CALCulate(Ch).SELected.FUNCtion.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The data array of analysis executed by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

The array size is 2N, where N is the number of points defined by the 
SCPI.CALCulate(Ch).SELected.FUNCtion.POINts property.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  the response value in the n–th measurement point; 

Data(2n–1)  the stimulus value in the n–th measurement point. 
Always set to 0 for the analysis of mean value, 
standard deviation, and peak–to–peak value. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DATA 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle 

Object Type Property (read/write) 

Data Type Boolean 

Target 
All traces of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The ON/OFF coupling state of the analysis range for the  
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.  

Allowable Values 
True:  Coupling state ON 
False: Coupling state OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle = Status 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt 

Object Type Property (read/write) 

Data Type Double 

Target 

All traces of channel Ch (if the coupling is set to OFF by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle property), the active 
trace of channel Ch (if otherwise), 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The start value of the analysis range set by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range From the stimulus current start value to the stimulus current stop value. 

Out of Range No limitation 

Preset Value 0 

Unit  Hz (Hertz) | s (second) |  dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt = 1e9 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

All traces of channel Ch (if the coupling is set to OFF by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle property), the active 
trace of channel Ch (if otherwise), 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The ON/OFF state of the arbitrary range when executing the analysis by the 
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Allowable Values 
True:  Arbitrary range ON 
False: Arbitrary range OFF (entire sweep range) 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe = True 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP 

Object Type Property (read/write) 

Data Type Double 

Target 

All traces of channel Ch (if the coupling is set to OFF by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle property), the active 
trace of channel Ch (if otherwise), 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The stop value of the analysis range set by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range From the stimulus current start value to the stimulus current stop value. 

Out of Range No limitation 

Preset Value 0 

Unit Hz (Hertz) | s (second) |  dBm (decibels above 1 milliwatt)  

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP = 2e9 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute 

Object Type Method 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description  

Executes the analysis specified with the 
SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE property. 
The analysis result can then be read out with the  
SCPI.CALCulate(Ch).SELected.FUNCtion.DATA property. 

Syntax app.SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The lower limit for the peak excursion value when executing the peak 
search by the SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range Varies depending on the trace format. 

Out of Range No limitation 

Preset Value 3 

Unit  dB (decibel) | ° (degree) | s (second)  

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion = 1.5 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.POINts 

Object Type Property (read only) 

Data Type Long 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The number of points (data pairs) of the analysis result by the  
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 
Always equal to 1, when the search is executed for the maximum, minimum, 
mean, standard deviation, peak, and peak–to–peak values. The actual 
number of points is read out, when the search is executed for all peaks or all 
targets. 

Syntax 
Dim Value As Long 

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.POINts 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The polarity selection when performing the peak search by the 
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range 

"POSitive" :  Positive peaks 

"NEGative" :  Negative peaks 

"BOTH" :  Both positive peaks and negative peaks 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "POS" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity = "NEG" 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.TARGet 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The target level when performing the search for the trace and the target level 
crosspoints by the SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range Varies depending on the trace format. 

Out of Range No limitation 

Preset Value 0 

Unit dB (decibel) | ° (degree) | s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TARGet 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.TARGet = –10 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The transition type selection when performing the search for the trace and 
the target level crosspoints by the 
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range 

"POSitive" :  Positive peaks 

"NEGative" :  Negative peaks 

"BOTH" :  Both positive peaks and negative peaks 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "POS" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition = "BOTH" 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The selection of the type of analysis executed by the 
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method. 

Range 

"PTPeak"             :   Peak–to–peak (difference between the maximum value 
and   the minimum value) 

"STDEV" :   Standard deviation 

"MEAN" :   Mean value 

"MAXimum" :   Maximum value 

"MINimum" :   Minimum value 

"PEAK" :   Search for the peak 

"APEak" :   Search for all the peaks 

"ATARget" :   Search for all targets 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "PTP" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE 

app.SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE = "STDEV" 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.LIMit.DATA 

Object Type Property (read/write) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The data array, which is the limit line in the limit test function. The array 
size is 1 + 5N, where N is the number of measuring points. 

For the n–th point, where n from 1 to N: 

Data(0) The number of limit line segments N is from 0 to 100. 
Setting 0 clears the limit line; 

Data(5n–4)  type of the n–th limit line segment; 

0: OFF 

1: Upper limit 

2: Lower limit 

Data(5n–3)  the stimulus value in the start point of the n–th 
segment; 

Data(5n–2)  the stimulus value in the end point of the n–th segment; 

Data(5n–1)  the response value in the start point of the n–th 
segment; 

Data(5n–0)  the response value in the end point of the n–th 
segment. 

Notes 

If the array size is not 1 + 5N, where N is Data(0), an error occurs (error 
code 214). If Data(5n – 4) is less than 0 or more than 2, an error occurs 
(error code 214). When Data(5n–3), Data(5n–2), Data(5n–1) and Data(5n–
0) elements are out of allowable range, the value is set to the limit, which is 
closer to the specified value. 

Syntax 

Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.LIMit.DATA 

app.SCPI.CALCulate(Ch).SELected.LIMit.DATA = Array(1,2,800,900,–10,–
10) 

Equivalent Softkeys Analysis > Limit Test > Edit Limit Line 
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SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the limit line display of the limit test function. 

Allowable Values 
True:  Limit line display ON 
False: Limit line display OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe 

app.SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe = True 

Equivalent Softkeys Analysis > Limit Test > Limit Line 
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SCPI.CALCulate(Ch).SELected.LIMit.FAIL 

Object Type Property (read only) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The limit test result. 

Allowable Values 
True:  Fail 
False: Pass 

Syntax 
Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.LIMit.FAIL 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.AMPLitude 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The value of the limit line offset along Y–axis. 

Range Varies depending on the trace format.  

Out of Range No limitation 

Preset Value 0 

Unit dB (decibel) | ° (degree) | s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.AMPLitude 

app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.AMPLitude = –10 

Equivalent Softkeys Analysis > Limit Test > Limit Line Offsets > Response Offset 
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SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The value of the limit line offset along X–axis. 

Range From the stimulus current start value to the stimulus current stop value. 

Out of Range No limitation 

Preset Value 0 

Unit Hz (Hertz) | s (second) |  dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus 

app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus = 1e6 

Equivalent Softkeys Analysis > Limit Test > Limit Lines Offsets > Stimulus Offset 
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SCPI.CALCulate(Ch).SELected.LIMit.REPort.ALL 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The data array, which is the limit test results. The array size is 4N, where N 
is the number of measurement points. 

For the n–th point, where n from 1 to N: 

Data(4n–3) the stimulus value in the n–th point 

Data(4n–2)  the limit test result in the n–th point 
–1: No limit 
0:  Fail 
1:  Pass 

Data(4n–1)  the upper limit value in the n–th point (0 – if there is no 
limit) 

Data(4n–0)  the lower limit value in the n–th point (0 – if there is no 
limit) 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort.ALL 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.LIMit.REPort.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The data array, which is the stimulus values at all the measurement points 
that failed the limit test. The array size is defined by the 
SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts property. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort.DATA 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts 

Object Type Property (read only) 

Data Type Long 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The number of the measurement points that failed the limit test.  

The array of stimulus values of the points can be read out by the  
SCPI.CALCulate(Ch).SELected.LIMit.REPort.DATA property. 

Syntax 
Dim Cnt  As Long 

Cnt  = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.LIMit.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the limit test function. 

Allowable Values 
True:  Limit test function ON 
False: Limit test function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.LIMit.STATe 

app.SCPI.CALCulate(Ch).SELected.LIMit.STATe = True 

Equivalent Softkeys Analysis > Limit Test > Limit Test 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).ACTivate 

Object Type Method 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 

Sets the active marker. If a marker is OFF this function will turn it ON.   

Turning ON a marker with the number from 1 to 15 will turn ON all the 
markers of smaller numbers. Turning ON the reference marker with number 
16 does not turn ON the markers with the numbers from 1 to 15, but 
switches these markers to the relative measurement mode. 

Syntax app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).ACTivate 

Equivalent Softkeys 
Markers > Active Marker > Marker n 

Markers > Reference Marker 

 

Table 4. Mk: Marker Number 

Data Type Long 

Description 
Marker number. Numbers from 1 to 15 are for regular markers, number 16 
is for the reference marker.  

Range from 1 to 16 

Out of Range An error occurs. Error code: 203. 

Notes If the marker number is not specified, it is taken as equal to 1.  
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 

The bandwidth search result. The bandwidth search can be performed 
relatively to the marker Mk, or relatively to the absolute maximum value of 
the trace (in this case the marker number is ignored), what is set by the 
SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.REFerence property.  

The array contains 4 elements: 

Data(0) Bandwidth; 

Data(1)  Center frequency; 

Data(2)  Q value; 

Data(3)  Loss. 

Notes 

If the bandwidth search is impossible, all the read out values are 0. If the 
search is performed relatively to a maker, which is OFF, an error occurs 
(error code 204). 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.DATA 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.REFerence 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The selection of the reference point for the bandwidth search function: 
reference marker or absolute maximum value of the trace. 

Range 

"MARKer" :  Bandwidth search relative to the reference marker 

"MAXimum" :  Bandwidth search relative to the absolute maximum of the 
trace 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "MAX" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.REFerence 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.REFerence = "MARK" 

Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Search Ref To 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the bandwidth search function. 

Allowable Values 
True:  Bandwidth search function ON 
False: Bandwidth search function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.STATe 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.STATe = True 

Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Bandwidth Search 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.THReshold 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The bandwidth definition value. 

Range Varies depending on the trace format. 

Out of Range No limitation 

Preset Value –3  

Unit dB (decibel) | ° (degree) | s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.THReshold 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.THReshold = –6.0 

Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Bandwidth Value 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The type of the bandwidth search function. 

Range 

"BPASs" : Bandpass 

"NOTCh" : Notch 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "BPAS" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.TYPE 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.TYPE = "NOTC" 

Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Type 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).COUPle 

Object Type Property (read/write) 

Data Type Boolean 

Target 
All traces of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the marker coupling function. 

Allowable Values 
True:  Marker coupling ON 
False: Marker coupling OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MARKer(1).COUPle 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).COUPle = false 

Equivalent Softkeys Markers > Properties > Marker Couple 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.DOMain.ST
ARt 

Object Type Property (read/write) 

Data Type Double 

Target 

All traces of channel Ch (if the marker search range coupling is set to OFF 
by the  SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle property), the 
active trace of channel Ch (if otherwise), 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The start value of the marker search range. 

Range From the stimulus current start value to the stimulus current stop value. 

Out of Range No limitation 

Preset Value 3e5 

Unit Hz (Hertz) | s (second) |  dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STARt 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STARt = 1e6 

Equivalent Softkeys Markers > Marker Search > Search Start 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.DOMain.ST
ATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

All traces of channel Ch (if the marker search range coupling is set to OFF 
by the SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.COUPle 
property), the active trace of channel Ch (if otherwise), 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the arbitrary range when executing the marker search. 

Allowable Values 
True:  Marker search range ON 
False: Marker search range OFF (entire sweep range) 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STATe 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STATe = True 

Equivalent Softkeys Markers > Marker Search > Search Range 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.DOMain.ST
OP 

Object Type Property (read/write) 

Data Type Double 

Target 

All traces of channel Ch (if the marker search range coupling is set to OFF 
by the SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.COUPle 
property), the active trace of channel Ch (if otherwise), 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The stop value of the marker search range. 

Range From the stimulus current start value to the stimulus current stop value. 

Out of Range No limitation 

Preset Value 1.5e9 

Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STOP 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STOP = 1e6 

Equivalent Softkeys Markers > Marker Search > Search Stop 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute 

Object Type Method 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Mk: marker number 1–15, or reference marker number 16 (see 

Table 4 on page 68) 

Description 

Executes the marker search according to the specified criterion. The type of 
the marker search is set by the  
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE property. 

Syntax app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute 

Equivalent Softkeys 

Markers > Marker Search > Maximum | Minimum  
 
Markers > Marker Search > Peak > Search Peak |  Search Max Peak | Search 
Peak Left | Search Peak Right  
 
Markers > Marker Search > Target > Search Target | Search Target Left | 
Search Target Right  
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PEXCursion 

Object Type Property (read/write) 

Data Type Double 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 
The peak excursion value, when the marker search for peak is performed by 
the SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute method. 

Range Varies depending on the trace format. 

Out of Range No limitation 

Preset Value 1  

Unit dB (decibel) | ° (degree) | s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PEXCursion 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PEXCursion = 3.0 

Equivalent Softkeys Markers > Marker Search > Peak > Peak Excursion 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PPOLarity 

Object Type Property (read/write) 

Data Type String 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 
The peak polarity selection, when the marker search for peak is performed 
by the SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute method. 

Range 

"POSitive" :  Positive polarity 

"NEGative" :  Negative polarity 

"BOTH" :  Both positive polarity and negative polarity 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "POS" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PPOLarity 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PPOLarity = "neg" 

Equivalent Softkeys Markers > Marker Search > Peak > Peak Polarity >  Positive | Negative | Both 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TARGet 

Object Type Property (read/write) 

Data Type Double 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 
The target value, when the marker search for target is performed by the  
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute method. 

Range Varies depending on the trace format. 

Out of Range No limitation 

Preset Value 0  

Unit dB (decibel) | ° (degree) | s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TARGet 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TARGet = –10 

Equivalent Softkeys Markers > Marker Search  > Target  > Target Value 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TRACking 

Object Type Property (read/write) 

Data Type Boolean 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description The ON/OFF state of the marker search tracking function. 

Allowable Values 
True:  Marker search tracking ON 
False: Marker search tracking OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TRACking 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TRACking = True 

Equivalent Softkeys Markers > Marker Search > Tracking 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TTRansition 

Object Type Property (read/write) 

Data Type String 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 

The selection of the type of the target transition, when the marker search for 
transition is performed by the 
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute method.  

Range 

"POSitive" :  Positive target transition 

"NEGative" :  Negative target transition 

"BOTH" :  Both positive target transition and negative target transition 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "POS" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TTRansition 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TTRansition = "NEG" 

Equivalent Softkeys Marker > Marker Search > Target > Target Transition  
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 
The selection of the type of the marker search, which is performed by the  
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute method. 

Range 

"MAXimum"  :  Maximum value search 

"MINimum"  :  Minimum value search 

"PEAK"  :  Peak search 

"LPEak"   :  Peak search to the left from the marker 

"RPEak"   :  Peak search to the right from the marker 

"TARGet"   :  Target search 

"LTARget"   :  Target search to the left from the marker  

"RTARget"   :  Target search to the right from the marker 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "MAX" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE = "MIN" 

Equivalent Softkeys 

Markers > Marker Search >  Maximum | Minimum  
 
Markers > Marker Search > Peak > Search Peak | Search Max Peak | Search 
Peak Left |  Search Peak Right  
 
Markers > Marker Search > Target > Search Target | Search Target Left | 
Search Target Right  
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).REFerence.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

The active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
(Mk – arbitrary number 1 to 16) 

Description 
The ON/OFF state of the reference marker. When the reference marker is 
turned ON, all the values of the other markers turn to relative values. 

Allowable Values 
True:  Reference marker ON 
False: Reference marker OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MARKer(1).REFerence.STATe 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).REFerence.STATe = True 

Equivalent Softkeys Markers > Reference Marker 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 86 

SCPI.CALCulate(Ch).SELected.MARKer(Mk).SET_ 

Object Type Property (write only) 

Data Type String 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Mk: marker number 1–15, or reference marker number 16 (see 

Table 4 on page 68) 

Description 
The setting of the value of the specified item to the value of the position of 
the marker. 

Range 

"STARt" : Sweep start value set to the stimulus value of the marker 
position. 

"STOP"  : Sweep stop value set to the stimulus value of the marker 
position. 

"CENTer"  : Sweep center value set to the stimulus value of the marker 
position. 

"RLEVel"  : Reference value set to the response value of the marker 
position. 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Syntax app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).SET_ = "STOP" 

Equivalent Softkeys 
Markers > Marker Functions > Marker–>Start | Marker–>Stop |  
Marker –>Center | Marker–>Ref Value  
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Mk: marker number 1–15, or reference marker number 16 (see 

Table 4 on page 68) 

Description 

The ON/OFF state of a marker. Turning ON a marker with the number from 
1 to 15 will turn ON all the markers of smaller numbers. Turning OFF a 
marker with the number from 1 to 15 will turn OFF all the markers of 
greater numbers (except for the reference marker). Turning ON/OFF the 
reference marker with number 16 does not turn ON/OFF the markers with 
the numbers from 1 to 15, but switches these markers to the relative 
measurement mode. 

Allowable Values 
True:  Marker ON 
False: Marker OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).STATe 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).STATe = True 

Equivalent Softkeys 
Markers > Add Marker | Remove Marker 

Markers > Reference Marker 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).X 

Object Type Property (read/write) 

Data Type Double 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
 Mk: marker number 1–15, or reference marker number 16 (see 

Table 4 on page 68) 

Description The stimulus value of the marker. 

Range From the stimulus current start value to the stimulus current stop value. 

Out of Value Sets the value of the limit, which is closer to the specified value. 

Preset Value Stimulus center value 

Unit Hz (Hertz) | s (second) |  dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).X 

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).X = 1e9 

Equivalent Softkeys Markers > Edit Stimulus 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).Y 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

Marker Mk of the active trace of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Mk: marker number 1–15, or reference marker number 16 (see 
Table 4 on page 68) 

Description 

The response value of the marker. If the reference marker is turned ON, the 
values of the markers from 1 to 15 are read out as relative values to the 
reference marker. 

The array includes 2 elements: 

Data(0)  real number in rectangular format, real part in polar 
and Smith chart formats; 

Data(1)  0 in rectangular format, imaginary part in polar and 
Smith chart formats. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).Y 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).COUNt 

Object Type Property (read/write) 

Data Type Long 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The number of the turned ON markers. 

Range from 0 to 16 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Syntax 

Dim MarkerCnt As Long 

MarkerCnt = app.SCPI.CALCulate(Ch).SELected.MARKer(1).COUNt 

app.SCPI.CALCulate(Ch).SELected.MARKer(1).COUNt = 5 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.MATH.FUNCtion 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The selection of the math operation between the measurement data and the 
memory trace data. The math result replaces the data trace. If the data trace 
is not saved, the command is ignored. 

Range 

"DIVide"  :  Division  Data / Mem.  

"MULTiply" :  Multiplication  Data x  Mem.  

"ADD"  :  Addition  Data + Mem. 

"SUBTract" :  Subtraction  Data – Mem.   

"NORMal"     :  No math   

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code 210. 

Preset Value "NORM" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.MATH.FUNCtion 

app.SCPI.CALCulate(Ch).SELected.MATH.FUNCtion= "DIV" 

Equivalent Softkeys Trace > Data Math > Data/Mem | Data*Mem | Data+Mem | Data–Mem | OFF 
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SCPI.CALCulate(Ch).SELected.MATH.MEMorize 

Object Type Method 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21)  

Description 
Saves the measurement data to the memory trace. Automatically turns on 
the display of the memory trace. 

Syntax app.SCPI.CALCulate(Ch).SELected.MATH.MEMorize 

Equivalent Softkeys Trace > Memorize Data Trace 
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SCPI.CALCulate(Ch).SELected.MAXhold.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the Maximum Hold function. 

Allowable Values 
True:  Maximum Hold ON 
False: Maximum Hold OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MAXhold.STATe 

app.SCPI.CALCulate(Ch).SELected.MAXhold.STATe = True 

Equivalent Softkeys Trace > Max Hold 
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SCPI.CALCulate(Ch).SELected.MSTatistics.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The math statistics data array. The statistics function is applied either over 
the whole range (for all the trace), or within the range specified by the 
SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.STATe property (the range 
limits are determined by two markers). 

The array includes 3 elements: 

Data(0) Mean value; 

Data(1)  Standard deviation; 

Data(2)  Peak–to–peak (difference between the maximum value 
and the minimum value).  

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.MSTatistics.DATA 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STARt 

Object Type Property (read/write) 

Data Type Long 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The number of the marker, which specifies the start frequency of the math 
statistics range. 

Range from 1 to 16 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1 

Syntax 

Dim MkrNum As Long 

MkrNum = app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STARt 

app.SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.MARKer.STARt = 3 

Equivalent Softkeys Markers > Marker Math > Statistics > Statistics Start 
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SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STOP 

Object Type Property (read/write) 

Data Type Long 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The number of the marker, which specifies the stop frequency of the math 
statistics range. 

Range from 1 to 16 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 2 

Syntax 

Dim Mkr As Long 

Mkr = app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STOP 

app.SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.MARKer.STOP = 4 

Equivalent Softkeys Markers > Marker Math > Statistics > Statistics Stop 
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SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the math statistics range. 

Allowable Values 
True:  Statistics range ON 
False: Statistics range OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.STATe 

app.SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.STATe = True 

Equivalent Softkeys Markers > Marker Math > Statistics > Statistics Range 
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SCPI.CALCulate(Ch).SELected.MSTatistics.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the math statistics display. 

Allowable Values 
True:  Statistics display ON 
False: Statistics display OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.MSTatistics.STATe 

app.SCPI.CALCulate(Ch).SELected.MSTatistics.STATe = True 

Equivalent Softkeys Markers > Marker Math > Statistics > Statistics 
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SCPI.CALCulate(Ch).SELected.RLIMit.DATA 

Object Type Property (read/write) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The data array, which is the limit line for the ripple limit function. The array 
size is 1 + 4N, where N is the number of limit line segments. 

For the n–th point, where n from 1 to N: 

Data(0) the number of limit line segments N is the integer from 
0 to 12. Setting 0 clears the limit line; 

Data(4n–3)  type of the n–th limit line segment; 
0: Off 

                          1: On 

Data(4n–2)  the stimulus value in the beginning point of the n–th 
segment;  

Data(4n–2)  the stimulus value in the end point of the n–th segment; 

Data(4n–0)   the ripple limit value of the n–th segment. 

Notes 

If the array size is not 1 + 4N, where N is Data(0), an error occurs (error 
code 214). If Data(4n – 3) is less than 0 or more than 1, an error occurs 
(error code 214). When Data(4n–2), Data(4n–1), and Data(4n–0) elements 
are out of allowable range, the value is set to the limit, which is closer to the 
specified value. 

Syntax 

Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.RLIMit.DATA 

app.SCPI.CALCulate(Ch).SELected.RLIMit.DATA = Array(1,1,800,900,10) 

Equivalent Softkeys Analysis > Ripple Limit > Edit Ripple Limit 
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SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21)  

Description The ON/OFF state of the ripple limit line display. 

Allowable Values 
True:  Ripple limit line ON 
False: Ripple limit line OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE 

app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE = True 

Equivalent Softkeys Analysis > Ripple Limit > Ripple Limit 
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SCPI.CALCulate(Ch).SELected.RLIMit.FAIL 

Object Type Property (read only) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Ripple limit test result. 

Allowable Values 
True:  Fail 
False: Pass 

Syntax 
Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.FAIL 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.RLIMit.REPort.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The data array, which is the ripple limit test results. The array size is 1+3N, 
where N is the number of ripple limit bands. 

For the n–th point, where n from 1 to N: 

Data(0) N total number of the bands; 

Data(3n–2)  n number of the band; 

Data(3n–1)  Ripple value in the n–th band; 

Data(3n–0)  Ripple limit test result in the n–th band: 
0:  Pass 

                          1:  Fail 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).SELected.RLIMit.REPort.DATA 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).SELected.RLIMit.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the ripple limit test. 

Allowable Values 
True: Ripple limit test ON 
False: Ripple limit test OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.STATe 

app.SCPI.CALCulate(Ch).SELected.RLIMit.STATe = True 

Equivalent Softkeys Analysis > Ripple Limit > Ripple Test 
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SCPI.CALCulate(Ch).SELected.SMOothing.APERture 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The smoothing aperture for the smoothing function. 

Range from 0.01 to 20 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1 

Unit % 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.SMOothing.APERture 

app.SCPI.CALCulate(Ch).SELected.SMOothing.APERture = 1.5 

Equivalent Softkeys Response > Smo Aperture 
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SCPI.CALCulate(Ch).SELected.SMOothing.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the trace smoothing function. 

Allowable Values 
True:  Trace smoothing ON 
False: Trace smoothing OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.SMOothing.STATe 

app.SCPI.CALCulate(Ch).SELected.SMOothing.STATe = True 

Equivalent Softkeys Response > Smoothing 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.CENTer 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
Еhe time domain center value, when the time domain transformation 
function is turned ON. 

Range 
Varies depending on the specified frequency range and the number of 
points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.CENTer 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.CENTer = 1e–8 

Equivalent Softkeys Analysis > Time Domain > Center 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.IMPulse.WIDTh 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The impulse width (time domain transformation resolution), coupled with 
the Kaiser–Bessel window shape β parameter. The impulse width setting 
changes the β parameter, and setting of β parameter changes the impulse 
width. 

Range 
Varies depending on the specified frequency range and the number of 
points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value None 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.IMPulse.WIDTh 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.IMPulse.WIDTh = 1e–8 

Equivalent Softkeys 
Analysis > Time Domain > Window > Impulse Width (when the transformation 
type is set to Bandpass or Lowpass Impulse) 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.KBESsel 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The β parameter, which controls the Kaiser–Bessel window shape, when 
performing time domain transformation. 

Range from 0 to 13 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 6 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.KBESsel 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.KBESsel = 13 

Equivalent Softkeys Analysis > Time Domain > Window > Kaiser Beta 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.LPFRequency 

Object Type Method 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
Changes the frequency range to match with the lowpass type of the time 
domain transformation function. 

Syntax app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.LPFRequency 

Equivalent Softkeys Analysis > Time Domain > Set Frequency Low Pass 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.REFLection 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The selection of the reflection type for the time domain transformation 
function. 

Range 

"RTRip"  Round Trip 

"OWAY" One Way 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "RTR" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.REFLection 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.REFLection = "OWAY" 

Equivalent Softkeys Analysis > Time Domain > Reflection Type > Round Trip | One Way 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 111 

SCPI.CALCulate(Ch).SELected.TRANsform.TIME.SPAN 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The time domain span value, when the time domain transformation function 
is turned ON. 

Range 
Varies depending on the specified frequency range and the number of 
points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 2e–8 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.SPAN 

app. SCPI.CALCulate(Ch).SELected.TRANsform.TIME.SPAN = 1e–8 

Equivalent Softkeys Analysis > Time Domain > Span 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STARt 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21)   

Description 
The start value used for the transformation function of the time domain 
function. 

Range 
Varies depending on the specified frequency range and the number of 
points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value –1e–8 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STARt 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STARt = 1e–8 

Equivalent Softkeys Analysis > Time Domain > Start 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the time domain transformation function. 

Allowable Values 
True:  Time domain transformation ON 
False: Time domain transformation OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STATe 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STATe = True 

Equivalent Softkeys Analysis > Time Domain > Time Domain 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STEP.RTIMe 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The rise time of the step signal (time domain transformation resolution), 
coupled with the Kaiser–Bessel window shape β parameter. The impulse 
width setting changes the β parameter, and setting of β parameter changes 
the impulse width. 

Range 
Varies depending on the specified frequency range and the number of 
points.  

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value None 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.IMPulse.WIDTh 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.IMPulse.WIDTh = 1e–8 

Equivalent Softkeys 
Analysis > Time Domain > Window > Impulse Width (when the transformation 
type is set to Lowpass Step) 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STIMulus 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The selection of the stimulus type for the time domain transformation 
function: impulse or step. 

Range 

"IMPulse"  Impulse  

"STEP" Step 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "IMP" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STIMulus 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STIMulus = "STEP" 

Equivalent Softkeys 
Analysis > Time Domain > Response Type > Bandpass | Lowpass Step | 
Lowpass Impulse  
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STOP 

Object Type Property (read/write) 

Data Type Double 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The time domain stop value, when the time domain transformation function 
is turned ON. 

Range 
Varies depending on the specified frequency range and the number of 
points. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1e–8 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STOP 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.STOP = 2e–8 

Equivalent Softkeys Analysis > Time Domain > Stop 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The selection of the transformation type for the time domain transformation 
function: bandpass response or direct current circuit. 

Range 

"BPASs" Bandpass 

"LPASs" Lowpass 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "BPASs" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.TYPE 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.TYPE = "STEP" 

Equivalent Softkeys 
Analysis > Time Domain > Response Type > Bandpass | Lowpass Step | 
Lowpass Impulse 
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SCPI.CALCulate(Ch).SELected.TRANsform.TIME.UNIT 

Object Type Property (read/write) 

Data Type String 

Target 
The active trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The selection of the unit for the time domain transformation function. 

Range 

"SEC" Seconds 

"MET" Metre 

"FEET" Feet 

Out of Range The value is ignored. 

Preset Value "SEC" 

Syntax 

Dim Param As String 

Param = app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.UNIT 

app.SCPI.CALCulate(Ch).SELected.TRANsform.TIME.UNIT = "MET" 

Equivalent Softkeys Analysis > Time Domain > Unit > Time, ns | Metric, m | Imperial, ft 
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SCPI.CALCulate(Ch).TRACe(Tr).DATA.FDATa 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

The specified trace Tr of channel Ch, 
Tr: trace number 1–8 (see Table 3 on page 29) 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The formatted data array. The array elements contain measurements in the 
current format, for example, in logarithmic magnitude format (Log Mag). 
Also, see section “Measurement Data Arrays” on page 19. 

The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  real number in rectangular format, real part in polar 
and Smith chart formats; 

Data(2n–1)  0 in rectangular format, imaginary part in polar and 
Smith chart formats. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch).Trace(Tr).DATA.FDATa 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch).TRACe(Tr).DATA.FMEMory 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

The specified trace Tr of channel Ch, 
Tr: trace number 1–8 (see Table 3 on page 29) 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The formatted memory array. The array elements contain saved 
measurements  in the current format, for example, in logarithmic magnitude 
format (Log Mag). Also, see section “Measurement Data Arrays” on page 
19. 

The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  real number in rectangular format, real part in polar 
and Smith chart formats; 

Data(2n–1)  0 in rectangular format, imaginary part in polar and 
Smith chart formats. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch). Trace(Tr).DATA.FMEMory 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.SDATa 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

The specified trace Tr of channel Ch, 
Tr: trace number 1–8 (see Table 3 on page 29) 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The corrected data array. The corrected measurements are complex 
numbers. Also, see section “Measurement Data Arrays” on page 19. 

 The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)   the real part of corrected measurement; 

Data(2n–1)  the imaginary part of corrected measurement. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch). Trace(Tr).DATA.SDATa 

Equivalent Softkeys None 
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.SMEMory 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

The specified trace Tr of channel Ch, 
Tr: trace number 1–8 (see Table 1 on page 21) 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The corrected memory array. The corrected measurements are complex 
numbers. Also, see section “Measurement Data Arrays” on page 19. 

The array size is 2N, where N is the number of measurement points.  

For the n–th point, where n from 1 to N: 

Data(2n–2)  the real part of corrected measurement memory; 

Data(2n–1)  the imaginary part of corrected measurement memory. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.CALCulate(Ch). Trace(Tr).DATA.SMEMory 

Equivalent Softkeys None 
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SCPI.DISPlay.ANNotation.FREQuency.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target Instrument 

Description The ON/OFF state of the frequency or time label on the channel window. 

Allowable Values 
True:  Frequency label display ON 
False: Frequency label display OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.DISPlay.ANNotation.FREQuency.STATe 

app.SCPI.DISPlay. ANNotation.FREQuency.STATe = False 

Equivalent Softkeys Display > Frequency Label 
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SCPI.DISPlay.COLor.BACK 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target Instrument 

Description 

The background color for trace display. 

The array contains 3 elements: 

Data(0) Red value R; 

Data(1)  Green value G; 

Data(2)  Blue value B. 

Range For all the array elements from 0 to 255. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 16, 16, 16 

Syntax 

Dim Data As Variant 

Data = app.SCPI.DISPlay.COLor.BACK 

app.SCPI.DISPlay.COLor.BACK = Array(0, 0, 0) 

Equivalent Softkeys Display > Color > Background 
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SCPI.DISPlay.COLor.GRATicule 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target Instrument 

Description 

The grid and the graticule label color for trace display. 

The array contains 3 elements: 

Data(0) Red value R; 

Data(1)  Green value G; 

Data(2)  Blue value B. 

Range For all array elements from 0 to 255. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 

Data(0) 63; 

Data(1)  63; 

Data(2)  63. 

Syntax 

Dim Data As Variant 

Data = app.SCPI.DISPlay.COLor.GRATicule 

app.SCPI.DISPlay.COLor. GRATicule = Array(128, 128, 128) 

Equivalent Softkeys Display > Color > Grid 
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SCPI.DISPlay.COLor.RESet 

Object Type Method 

Target Instrument 

Description Restores the display settings to the default values. 

Syntax app.SCPI.DISPlay.COLor.RESet 

Equivalent Softkeys Display > Set Defaults 
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SCPI.DISPlay.COLor.TRACe(Tr).DATA 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target 
Trace number Tr in all channels, 

Tr: trace number 1–8 (see Table 3 on page 29) 

Description 

The data trace color. 
The array contains 3 elements: 

Data(0) Red value R; 

Data(1)  Green value G; 

Data(2)  Blue value B. 

Range For all array elements from 0 to 255. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the trace number. 

Syntax 

Dim Data As Variant 

Data = app.SCPI.DISPlay.COLor.TRACe(Tr).DATA 

app.SCPI.DISPlay.COLor.TRACe(Tr).DATA = Array(255, 255, 0) 

Equivalent Softkeys Display > Color > Data Trace 
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SCPI.DISPlay.COLor.TRACe(Tr).MEMory 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target 
Trace number Tr in all channels 

Tr: trace number 1–8 (see Table 3 on page 29) 

Description 

The memory trace color. 

The array contains 3 elements: 

Data(0) Red value R; 

Data(1)  Green value G; 

Data(2)  Blue value B. 

Range For all array elements from 0 to 255. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the trace number. 

Syntax 

Dim Data As Variant 

Data = app.SCPI.DISPlay.COLor.TRACe(Tr).MEMory 

app.SCPI.DISPlay.COLor.TRACe(Tr). MEMory = Array(255, 255, 0) 

Equivalent Softkeys Display > Color > Memory Trace 
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SCPI.DISPlay.FSIGn 

Object Type Property (read/write) 

Data Type Boolean 

Target Instrument 

Description 
The ON/OFF state of the Fail sign display, when performing limit test or 
ripple limit test. 

Allowable Values 
True:  Fail sign display ON 
False: Fail sign display OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.DISPlay.FSIGn 

app.SCPI.DISPlay.FSIGn = True 

Equivalent Softkeys 
Analysis > Limit Test > Fail Sign 

Analysis > Ripple Limit > Fail Sign 
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SCPI.DISPlay.IMAGe 

Object Type Property (read/write) 

Data Type String 

Target Instrument 

Description The inverted color display of the data traces. 

Range 

"NORMal"  :  Normal display 

"INVert" :  Inverted color display 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "NORM" 

Syntax 

Dim Param As String 

Param = app.SCPI.DISPlay.IMAGe 

app.SCPI.DISPlay.IMAGe = "INV" 

Equivalent Softkeys Display > Invert Color 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 131 

SCPI.DISPlay.MAXimize 

Object Type Property (read/write) 

Data Type Boolean 

Target Active Channel 

Description The ON/OFF maximize state of the active channel window. 

Allowable Values 
True:  Maximize active chanel state ON 
False: Maximize active chanel state OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.DISPlay.MAXimize 

app.SCPI.DISPlay.MAXimize = True 

Equivalent Softkeys Channel > Maximize Channel 
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SCPI.DISPlay.SPLit 

Object Type Property (read/write) 

Data Type Long 

Target Instrument 

Description 
The number and layout of the channel windows on the screen. The channel 
window layout is in Table 5 below. 

Range from 1 to 10 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1 

Syntax 

Dim Value As Long 

Value = app.SCPI.DISPlay.SPLit 

app.SCPI.DISPlay.SPLit = 2 

Equivalent Softkeys Channel > Allocate channels 

 

Table 5. Channel Window Layout on the Screen 

1:      2:       3:       

4:       5:       6:       

7:       8:       9:       

10:       
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SCPI.DISPlay.UPDate_.IMMediate 

Object Type Method 

Target Instrument 

Description 
Updates the display once, when the display update is set to OFF 
(SCPI.DISPlay.ENABle property is set to False). 

Syntax app.SCPI.DISPlay.UPDate_.IMMediate 

Equivalent Softkeys None 

 

SCPI.DISPlay.WINDow(Ch).ACTivate 

Object Type Method 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Sets the active channel. 

Notes 
The channel window must be displayed. At attempt to set to the active 
channel the channel, which is not displayed, an error occurs. 

Syntax app.SCPI.DISPlay.WINDow(Ch).ACTivate 

Equivalent Softkeys 
Channel > Active Channel 
Trace > Active Trace 
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SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGn.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The alignment mode of the marker display position of each trace, when the 
only active trace display feature is turned OFF  
(SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe property is set 
to False). 

Range  

"VERTical"  :  Vertical alignment  

"HORizontal" :  Horizontal alignment 

"NONE" :  No alignment 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "NONE" 

Syntax 

Dim Param As String 

Param = app.SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGn.TYPE 

app.SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGn.TYPE = "VERT" 

Equivalent Softkeys Markers > Properties > Align > Vertical | Horizontal | OFF 
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SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the marker display for the active trace only. 

Allowable Values 
True:  Only active trace markers display ON 
False: Only active trace markers display OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe 

app.SCPI SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe = True 

Equivalent Softkeys Markers > Properties > Active Only 
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SCPI.DISPlay.WINDows(Ch).MAXimize 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Active Trace of channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF maximize state of the active trace for channel window. 

Allowable Values 
True:  Maximize active trace state ON 
False: Maximize active trace state OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.DISPlay.WINDows(1).MAXimize 

app.SCPI.DISPlay.WINDows(1).MAXimize = True 

Equivalent Softkeys Trace  >  Maximize Trace 
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SCPI.DISPlay.WINDows(Ch).SPLit 

Object Type Property (read/write) 

Data Type Long 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The number and layout of the trace on the channel window. The trace layout 
is in Table 6 below. 

Range From 1 to 9 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1 

Syntax 

Dim Value As Long 

Value = app.SCPI.DISPlay.WINDows(1).SPLit 

app. app.SCPI.DISPlay.WINDows(1).SPLit = 2 

Equivalent Softkeys Trace  ->  Allocate Traces 

 

Table 6. Trace Layout on the Channel Window 

1:      2:       3:       

4:      5:       6:       

7:      8:       9:       
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SCPI.DISPlay.WINDow(Ch).TITLe.DATA 

Object Type Property (read/write) 

Data Type String 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The channel title label. 

Range up to 254 characters 

Preset Value "" 

Syntax 

Dim Text  As String 

Text  = app.SCPI.DISPlay.WINDow(Ch).TITLe.DATA 

app.SCPI.DISPlay.WINDow(Ch).TITLe.DATA = "Example1" 

Equivalent Softkeys None 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 139 

SCPI.DISPlay.WINDow(Ch).TITLe.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the title label display. 

Allowable Values 
True:  Title label display ON 
False: Title label display OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.DISPlay.WINDow(Ch).TITLe.STATe 

app.SCPI.DISPlay.WINDow(Ch).TITLe.STATe = True 

Equivalent Softkeys Display > Title Label 
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.
X 

Object Type Property (read/write) 

Data Type Double 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description 
The display position of the marker value on the X–axis by a percentage of 
the display width. 

Range from 0 to 100 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit % 

Syntax 

Dim Value As Double 

Value = 
app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.X 

app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.X = 50 

Equivalent Softkeys Markers > Properties > Data X Position 
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.
Y 

Object Type Property (read/write) 

Data Type Double 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description 
The display position of the marker value on the Y–axis by a percentage of 
the display height. 

Range from 0 to 100 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit % 

Syntax 

Dim Value As Double 

Value = 
app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.Y 

app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.Y = 50 

Equivalent Softkeys Markers > Properties > Data Y Position 
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.AUTO 

Object Type Method 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description Executes the auto scale function for the trace. 

Syntax app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.AUTO 

Equivalent Softkeys Scale > Auto Scale 
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.PDIVision 

Object Type Property (read/write) 

Data Type Double 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description 

The trace scale. Sets the scale per division, when the data format is the 
rectangular format. Sets the full scale value, when the data format is the 
Smith chart format or the polar format. 

Range from 10E–18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 

Varies depending on the format. 
Logarithmic Magnitude: 10 dB/Div 
Phase: 40 °/Div 
Expand Phase: 100 °/Div 
Group Delay: 10e–9 s/Div 
Smith Chart, Polar, SWR: 1 /Div 
Linear Magnitude: 0.1 /Div 
Real part,  Imaginary part: 0.2 /Div 

Unit 
dB/Div (decibel per division), °/Div (degree per division), s/Div (second per 
division) 

Syntax 

Dim Value As Double 

Value = app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.PDIVision 

app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.PDIVision = 20 

Equivalent Softkeys Scale > Scale 
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RLEVel 

Object Type Property (read/write) 

Data Type Double 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description 
The value of the reference line (response value on the reference line). For 
the rectangular format only. 

Range from –1E–18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 (except for SWR: 1) 

Unit dB (decibel) | ° (degree) | s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RLEVel 

app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RLEVel = 10 

Equivalent Softkeys Scale > Ref Value 
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RPOSition 

Object Type Property (read/write) 

Data Type Long 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description The position of the reference line. For the rectangular format only. 

Range 
From 0 to the number of the scale divisions (set by the 
SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions property, 10 by default). 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 5 (except for SWR: 0) 

Syntax 

Dim Value As Long 

Value = app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RPOSition 

app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RPOSition = 10 

Equivalent Softkeys Scale > Ref Position 
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SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions 

Object Type Property (read/write) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21). 

Description The number of the vertical scale divisions. For the rectangular format only. 

Range from 4 to 20 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 
 10 

Resolution 2 

Syntax 

Dim Value As Long 

Value = app.SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions 

app.SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions = 12 

Equivalent Softkeys Scale > Divisions 
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SCPI.HCOPy.DATE.STAMp 

Object Type Property (read/write) 

Data Type Boolean 

Target Instrument 

Description 
The ON/OFF state of the current date and time printout in the upper right 
corner. 

Allowable Values 
True:  Date & time printout ON 
False: Date & time printout OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.HCOPy.DATE.STAMp 

app.SCPI.HCOPy.DATE.STAMp = False 

Equivalent Softkeys System > Print > Print Date & Time 
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SCPI.HCOPy.IMAGe 

Object Type Property (read/write) 

Data Type String 

Target Instrument 

Description The inverted color image printout. 

Range 

"NORMal"  :  Normal printout 

"INVert" :  Inverted color printout 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "NORM" 

Syntax 

Dim Param As String 

Param = app.SCPI.HCOPy.IMAGe 

app.SCPI.HCOPy.IMAGe = "INV" 

Equivalent Softkeys System > Print > Invert Image 
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SCPI.HCOPy.IMMediate 

Object Type Method 

Target Instrument 

Description Prints out the image displayed on the screen without previewing. 

Syntax app.SCPI.HCOPy.IMMediate 

Equivalent Softkeys System > Print > Print Embedded 
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SCPI.HCOPy.PAINt 

Object Type Property (read/write) 

Data Type String 

Target Instrument 

Description The color chart for the image printout. 

Range 

"COLor"  :  Color printout   

"GRAY" :  Grayscale printout 

"BW" :  Black&white printout 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range The value is ignored. 

Preset Value "BW" 

Syntax 

Dim Param As String 

Param = app.SCPI.HCOPy.PAINt 

app.SCPI.HCOPy.PAINt = "COL" 

Equivalent Softkeys System > Print > Print Color 
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SCPI.IEEE4882.IDN 

Object Type Property (read only) 

Data Type String 

Target Instrument 

Description 
The instrument information string. The string format: ''{manufacturer}, 
{model}, {serial number}, {software version/firmware version}''. 

Range up to 40 characters 

Syntax 
Dim ID As String 

ID = app.NAME 

Equivalent Softkeys None 
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SCPI.IEEE4882.RST 

Object Type Method 

Target Instrument 

Description 

Restores the default settings of the instrument. There is difference from 
presetting the instrument with the SCPI.SYSTem.PRESet method – in this 
case the trigger mode is set to Hold. 

Syntax app.SCPI.IEEE4882.RST 

Equivalent Softkeys None 

 
 

SCPI.IEEE4882.TRG 

Object Type Method 

Target Instrument 

Description 

If the trigger source is set to LAN (SCPI.TRIGger.SEQuence.SOURce property 
is set to ''BUS'' ), triggers a sweep. 
If the trigger source is not set to the bus (SCPI.TRIGger.SEQuence.SOURce 

property is not set to ''BUS'' ) or the instrument is not waiting for a trigger, 
the method is ignored. 

Syntax app.SCPI.IEEE4882.TRG 

Related Commands 
SCPI.TRIGger.SEQuence.SOURce 
SCPI.INITiate(Ch).CONTinuous  
SCPI.INITiate(Ch).IMMediate 

Equivalent Softkeys None 
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SCPI.IEEE4882.WAI 

Object Type Method 

Target Instrument 

Description Waits for the execution of all commands sent before this command. 

Syntax app.SCPI.IEEE4882.WAI 

Equivalent Softkeys None 
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SCPI.INITiate(Ch).CONTinuous 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The ON/OFF state of the continuous trigger initiation mode. If the 
continuous trigger initiation mode is set to OFF, the channel turns to the 
hold state. 

Allowable Values 
True:  Continuous trigger initiation mode ON 
False: Continuous trigger initiation mode OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.INITiate(Ch).CONTinuous 

app.SCPI.INITiate(Ch).CONTinuous = False 

Notes 

The sweep start in continuous trigger initiation mode depends on the trigger 
source. If the trigger is set to internal, the sweeps will go immediately one 
after another. If the trigger is set otherwise, the sweep will start when the 
trigger signal is received. 

Equivalent Softkeys 
Stimulus > Trigger > Continuous  
Stimulus > Trigger > Hold 
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SCPI.INITiate(Ch).IMMediate 

Object Type Method 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Sets the channel to the single trigger mode. Before this method is called, the 
channel must be in hold state, otherwise an error occurs (error code 213) and 
the method is ignored. 

On completion of the sweep, the channel goes back into the hold state. 

The method returns control before the end of the sweep. 

Syntax app.SCPI.INITiate(Ch).IMMediate 

Notes 

The sweep start in the single trigger mode depends on the trigger source. If 
the trigger is set to internal, the sweep will start immediately after the 
method is called. If the trigger is set otherwise, the sweep will start when the 
trigger signal is received. 

Equivalent Softkeys Stimulus > Trigger > Single 
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SCPI.MMEMory.COPY(Src, Dst) 

Object Type Method 

Target Instrument 

Description Copies a file.  

Syntax app.SCPI.MMEMory.COPY(Src, Dst) 

Parameter 
Src – Source file name. String data type.  

Dst – Destination file name. String data type.  

Equivalent Softkeys None 

 

SCPI.MMEMory.DELete(File) 

Object Type Method 

Target Instrument 

Description Deletes a file. 

Syntax app.SCPI.MMEMory.DELete(File) 

Parameter File – File name. String data type. 

Equivalent Softkeys None 
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SCPI.MMEMory.LOAD.CKIT(Ck) 

Object Type Property (write only) 

Data Type String 

Target 
Calibration kit Ck, 

Ck: calibration kit number 1–11 (see Table 7 on page 157) 

Description 
Recalls the definition file for the calibration kit. The file must be saved by 
the SCPI.MMEMory.STORe.CKIT(Ck) property. 

Range up to 254 characters  

Syntax app.SCPI.MMEMory.LOAD.CKIT(Ck) = File 

Notes 

If the full path to the file is not specified, the \CalKit  subdirectory of the 
main directory will be searched for the file. The calibration kit definition file 
has *.ckd extension by default. 

Equivalent Softkeys None 

 

Table 7. Ck:  Calibration Kit Number 

Data Type Long 

Description Calibration kit number. 

Range from 1 to 16 

Out of Range An error occurs. Error code: 114. 

Notes If the calibration kit number is not specified, it is taken as equal to 1.  
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SCPI.MMEMory.LOAD.CALibration 

Object Type Property (write only) 

Data Type String 

Target User calibration of the active channel. 

Description 
Recalls the specified calibration file. The file must be saved by the 

SCPI.MMEMory.STORe.CALibration property.  

Range up to 254 characters  

Syntax app.SCPI.MMEMory.LOAD.CALibration = File 

Notes 

If the full path to the file is not specified, the \State subdirectory of the main 
directory will be searched for the file. The calibration files have *.cal 
extension by default. 

Equivalent Softkeys System > Recall > Calibration 
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SCPI.MMEMory.LOAD.LIMit 

Object Type Property (write only) 

Data Type String 

Target Active trace of the active channel. 

Description 
Recalls the specified limit table file. The file must be saved by the 

SCPI.MMEMory.STORe.LIMit property.  

Range up to 254 characters  

Syntax app.SCPI.MMEMory.LOAD.LIMit = File 

Notes 

If the full path to the file is not specified, the \Limit subdirectory of the main 
directory will be searched for the file. The limit table files have *.lim 
extension by default. 

Equivalent Softkeys Analysis > Limit Test > Edit Limit Line > Restore Limit Table 
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SCPI.MMEMory.LOAD.RLIMit 

Object Type Property (write only) 

Data Type String 

Target Active trace of the active channel. 

Description 
Recalls the ripple limit table file. The file must be saved by the 
SCPI.MMEMory.STORe.RLIMit property. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.LOAD.RLIMit = File 

Notes 

If the full path to the file is not specified, the \Limit subdirectory of the main 
directory will be searched for the file. The ripple limit files have *.rlm 
extension by default. 

Equivalent Softkeys Analysis > Ripple Limit > Edit Ripple Limit > Restore Ripple Limit Table 
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SCPI.MMEMory.LOAD.SEGMent 

Object Type Property (write only) 

Data Type String 

Target Active channel 

Description 
Recalls the segment table file. The file must be saved by the 
SCPI.MMEMory.STORe.SEGMent property. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.LOAD.SEGMent = File 

Notes 

If the full path to the file is not specified, the \Segment subdirectory of the 
main directory will be searched for the file. The segment files have *.seg 
extension by default. 

Equivalent Softkeys Stimulus > Segment Table > Recall 
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SCPI.MMEMory.LOAD.STATe 

Object Type Property (write only) 

Data Type String 

Target Instrument 

Description 
Recalls the specified instrument state file. The file must be saved by the 

SCPI.MMEMory.STORe.STATe property.  

Range up to 254 characters 

Syntax app.SCPI.MMEMory.LOAD.STATe = File 

Notes 

If the full path to the file is not specified, the \State subdirectory of the main 
directory will be searched for the file. The instrument state files have *.cfg 
extension by default. 

Equivalent Softkeys 
System > Recall > State 
System > Recall > Calibration 
System > Recall > State and Calibration 
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SCPI.MMEMory.MDIRectory 

Object Type Property (write only) 

Data Type String 

Target Instrument 

Description 
Creates a new directory (folder). Contains the full path to the folder being 
created. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.MDIRectory = Path 

Equivalent Softkeys None 
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SCPI.MMEMory.STORe.CKIT(Ck) 

Object Type Property (write only) 

Data Type String 

Target 
Calibration kit Ck, 

Ck: calibration kit number 1–11 (see Table 7 on page 157) 

Description Saves the definition file for the calibration kit parameters. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.CKIT(Ck) = File 

Notes 

If the full path to the file is not specified, the file will be saved to the \CalKit 
subdirectory of the main directory. The calibration kit definition file has 
*.dat extension by default. 

Equivalent Softkeys None 
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SCPI.MMEMory.STORe.CALibration 

Object Type Property (write only) 

Data Type String 

Target User calibration of the active channel. 

Description Save the specified calibration file.  

Range up to 254 characters  

Syntax app.SCPI.MMEMory.STORe.CALibration = File 

Notes 

If the full path to the file is not specified, the \State subdirectory of the main 
directory will be used for the file. The calibration files have *.cal extension 
by default. 

Equivalent Softkeys System > Save > Calibration 
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SCPI.MMEMory.STORe.FDATa 

Object Type Property (write only) 

Data Type String 

Target Active trace of the active channel 

Description Saves the CSV formatted data into a file.  

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.FDATa = File 

Notes 
If the full path to the file is not specified, the file will be saved to the \CSV 
subdirectory of the main directory. The files have *.csv extension by default. 

Equivalent Softkeys System > Save > Save Trace Data 
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SCPI.MMEMory.STORe.IMAGe 

Object Type Property (write only) 

Data Type String 

Target Instrument 

Description Saves the display image in BMP or PNG format into a file. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.IMAGe = File 

Notes 

If the full path to the file is not specified, the file will be saved to the \Image 
subdirectory of the main directory. If the file has *.png extension, the file 
has PNG format, in all the other cases the file has BMP format. 

Equivalent Softkeys System > Print > Print Windows 
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SCPI.MMEMory.STORe.LIMit 

Object Type Property (write only) 

Data Type String 

Target Active trace of the active channel 

Description Saves the limit table into a file with the specified name.  

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.LIMit = File 

Notes 

If the full path to the file is not specified, the file will be saved to the \Limit 
subdirectory of the main directory. The files have *.lim extension by default. 
 

Equivalent Softkeys Analysis > Limit Test > Edit Limit Line > Save Limit Table 
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SCPI.MMEMory.STORe.RLIMit 

Object Type Property (write only) 

Data Type String 

Target Active trace of the active channel 

Description Saves the ripple limit table into a file with the specified name. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.RLIMit = File 

Notes 

If the full path to the file is not specified, the file will be saved to the \Limit 
subdirectory of the main directory. The ripple limit files have *.rlm 
extension by default. 

Equivalent Softkeys Analysis > Ripple Limit > Edit Ripple Limit > Save Ripple Limit Table 
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SCPI.MMEMory.STORe.SEGMent 

Object Type Property (write only) 

Data Type String 

Target Active channel 

Description Saves the segment table in a file with the specified name.  

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.SEGMent = File 

Notes 

If the full path to the file is not specified, the file will be saved to the 
\Segment subdirectory of the main directory. The segment files have *.seg 
extension by default. 

Equivalent Softkeys Stimulus > Segment Table > Save 
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SCPI.MMEMory.STORe.SNP.DATA 

Object Type Property (write only) 

Data Type String 

Target Active channel 

Description 

Saves the measured S–parameters of the active channel into a Touchstone 
file with the specified name. The file type (1–port or 2–port) is set by the 
SCPI.MMEMory.STORe.SNP.TYPE.S1P and 
SCPI.MMEMory.STORe.SNP.TYPE.S2P properties. 1–port type file saves one 
reflection parameter: S11. 2–port type file saves the two parameters: S11, 
S21. 

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.SNP.DATA = File 

Notes 

If the full path to the file is not specified, the file will be saved to the 
\FixtureSim subdirectory of the main directory. The 1–port measurement 
files have *.slp extension; the 2–port measurement files have *.s2p 
extension. 

Equivalent Softkeys System >Save > Touchstone File > Save 
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SCPI.MMEMory.STORe.SNP.FORMat 

Object Type Property (read/write) 

Data Type String 

Target Active channel 

Description 
The data format for the S–parameters saving by the 
SCPI.MMEMory.STORe.SNP.DATA property. 

Range 

"MA"  :  Logarithmic Magnitude / Angle format 

"DB"  :  Linear Magnitude / Angle format    

"RI"  :  Real part /Imaginary part format    

Out of Range The value is ignored. 

Preset Value "RI" 

Syntax 

Dim Param As String 

Param = app.SCPI.MMEMory.STORe.SNP.FORMat 

app.SCPI.MMEMory.STORe.SNP.FORMat = "DB" 

Equivalent Softkeys System > Save > Touchstone File > Format 
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SCPI.MMEMory.STORe.SNP.TYPE.S1P 

Object Type Property (read/write) 

Data Type Long 

Target Active channel 

Description 

Selects 1-port measurements and sets port numbers (selects S11 parameter) 
when saving the measured S-parameters by the 
SCPI.MMEMory.STORe.SNP.DATA property.  

Range from 1 to 2 

Out of Range An error occurs. Error code 222. 

Preset Value 1 

Syntax 

Dim Value As Long 

Value = app.SCPI.MMEMory.STORe.SNP.TYPE.S1P 

app.SCPI.MMEMory.STORe.SNP.TYPE.S1P = 2 

Equivalent Softkeys 
System > Save > Touchstone File > Type > 1–Port (s1p) 
 
System >Save > Touchstone File > Select Port (s1p) 
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SCPI.MMEMory.STORe.SNP.TYPE.S2P 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target Active channel 

Description 

Selects 2-port measurements and sets port numbers when saving the 
measured S-parameters by the SCPI.MMEMory.STORe.SNP.DATA property.  

The array contains 2 elements:  

Data(0) First port number (reads out 1, ignored when written); 

Data(1)  Second port number  (reads out 2, ignored when 
written). 

Syntax 

Dim Data As Variant 

Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S2P 

app.SCPI.MMEMory.STORe.SNP.TYPE.S2P = Array(1, 2) 

Equivalent Softkeys System > Save > Touchstone File > Type > 2–Port (s2p) 
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SCPI.MMEMory.STORe.STATe 

Object Type Property (write only) 

Data Type String 

Target Instrument  

Description Saves the instrument state into a file with the specified name.  

Range up to 254 characters 

Syntax app.SCPI.MMEMory.STORe.STATe = File 

Notes 

If the full path to the file is not specified, the file will be saved to the \State 
subdirectory of the main directory. The state files have *.cfg extension by 
default. 

Equivalent Softkeys System > Save > State 
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SCPI.MMEMory.STORe.STYPe 

Object Type Property (read/write) 

Data Type String 

Target Instrument  

Description 

Selects the type of the instrument or channel state saving by the 
SCPI.MMEMory.STORe.STATe or SCPI.MMEMory.STORe.CHANnel.STATe 

property. 

Range 

"STATe"  : Measurement conditions 

"CSTate"  : Measurement conditions and calibration tables 

"DSTate"  : Measurement conditions and data traces 

"CDSTate"   : Measurement conditions, calibration tables and data traces 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code 205. 

Preset Value "CST" 

Syntax 

Dim Param As String 

Param = app.SCPI.MMEMory.STORe.STYPe 

app.SCPI.MMEMory.STORe.STYPe = "STATe" 

Equivalent Softkeys None 
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SCPI.OUTPut.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target Instrument  

Description 
Sets the ON/OFF state of the stimulus signal output. Measurements cannot 
be performed when the stimulus signal output is set to OFF. 

Allowable Values 
True:   Stimulus signal output ON 
False:  Stimulus signal output OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.OUTPut.STATe 

app.SCPI.OUTPut.STATe = False 

Equivalent Softkeys Stimulus > Power > RF Out 
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SCPI.SENSe(Ch).AVERage.CLEar 

Object Type Method 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Resets the averaging data count to 0. Restarts the averaging process.  

Syntax app.SCPI.SENSe(Ch).AVERage.CLEar 

Equivalent Softkeys None 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 179 

SCPI.SENSe(Ch).AVERage.COUNt 

Object Type Property (read/write) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The averaging factor, when the averaging function is set to ON by the 
SCPI.SENSe(Ch).AVERage.STATe property. 

Range from 1 to 999 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 10 

Syntax 

Dim Value As Long 

Value = app.SCPI.SENSe(Ch).AVERage.COUNt 

app.SCPI.SENSe(Ch).AVERage.COUNt = 2 

Equivalent Softkeys Response > Avg Factor 
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SCPI.SENSe(Ch).AVERage.CURRent 

Object Type Property (read only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The current step of averaging. 

Range from 1 to Averaging Factor 

Syntax 
Dim Value As Long 

Value = app.SCPI.SENSe(Ch).AVERage.CURRent 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).AVERage.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the averaging function. 

Allowable Values 
True:  Averaging ON 
False: Averaging OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).AVERage.STATe 

app.SCPI.SENSe(Ch).AVERage.STATe = False 

Equivalent Softkeys Response > Averaging 
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SCPI.SENSe(Ch).BANDwidth.RESolution 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The IF bandwidth value. 

Range from 10 to 30000 

Resolution In steps of 3. (10, 30, 100, 300, 1000, 3000, 10000, 30000) 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 10000 

Unit Hz (Hertz) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).BANDwidth.RESolution 

app.SCPI.SENSe(Ch).BANDwidth.RESolution = 100 

Equivalent Softkeys Response > IF Bandwidth 
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SCPI.SENSe(Ch).CORRection.CLEar 

Object Type Method 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Clears the calibration coefficient table. 

Syntax app.SCPI.SENSe(Ch).CORRection.CLEar 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COEFficient.DATA(Str, Pt_r, Pt_s) 

Object Type Property (read) 

Data Type Variant (Double array) 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21)  

Description 

The calibration coefficient data array set by the type of  the corrected error  
Str,  the number of the receiver port  Pt_r and  the number of the source port  
Pt_s, 

Str       :  error type (see below) 
Pt_r     : the number of the receiver port 1–2 (see Table 2 on page 21) 
Pt_s     : the number of the source port 1–2 (see Table 2 on page 21) 

The array size is 2N, where N is the number of measurement points. 

For the n–th point, where n from 1 to N: 

Data(2n–2)  real part of the calibration coefficients 

Data(2n–1)  imaginary part of the calibration coefficients 

Parameter 

String Str – corrected error type: 
"ES": Source match 
"ER": Reflection tracking 
"ED":  Directivity 
"EL": Load match 
"ET": Transmission tracking 
"EX":  Isolation 

 
When ES, ER, or ED is used, the numbers of the ports Pt_r and Pt_s must 
be the same. When EL, ET, or EX is used, the numbers of the ports Pt_r and 
Pt_s must be different. 

Syntax 
Dim Data As Variant 

Data = app.SCPI.SENSe(Ch).CORRection.COEFficient.DATA (Str, Pt_r, Pt_s) 

Notes 
The written calibration coefficients become effective only after the 
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method is invoked. 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Measures the calibration data of the load standard for the specified port. 

Range Port number is 1 or 2. 

Out of Range An error occurs (error code: 222). 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD = 1 

Notes 

The property writing starts the measurement for the channel independently 
of the trigger initiation and trigger source settings. The function of the 
property writing waits for the completion of the measurement. 

Equivalent Softkeys 

Calibration > Response (Open) > Load (Optional) 
 
Calibration > Response (Short) > Load (Optional) 
 
Calibration > Full 1–Port Cal > Load 
 
Calibration > One Path 2–Port Cal > Load 
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.OPEN 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Measures the calibration data of the open standard for the specified port. 

Range Port number is 1 or 2. 

Out of Range An error occurs (error code: 222). 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.OPEN= 1 

Notes 

The property writing starts the measurement for the channel independently 
of the trigger initiation and trigger source settings. The function of the 
property writing waits for the completion of the measurement. 

Equivalent Softkeys 

Calibration > Response (Open) > Open 
 
Calibration > Full 1–Port Cal  > Open 
 
Calibration > One Path 2–Port Cal > Open 
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SHORt 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Measures the calibration data of the short standard for the specified port. 

Range Port number is 1 or 2. 

Out of Range An error occurs (error code: 222). 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SHORt = 1 

Notes 

The property writing starts the measurement for the channel independently 
of the trigger initiation and trigger source settings. The function of the 
property writing waits for the completion of the measurement. 

Equivalent Softkeys 

Calibration > Response (Short) > Short 
 
Calibration > Full 1–Port Cal > Short 
 
Calibration > One Path 2–Port Cal > Short 
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.THRU 

Object Type Property (write only) 

Data Type Variant (Long array) 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Measures the calibration data of the thru standard between the source port 
and the receiver port. 

The array contains 2 elements: 

Data(0) the number of the receiver port; 

Data(1) the number of the source port. 

Range 
Port number is 1 or 2. The array elements can not contain the same port 
numbers. 

Out of Range 
If an incorrect port number is specified, an error occurs (error code: 222). If 
the same port numbers are specified, an error occurs (error code: 220). 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.THRU= Array(1, 2) 

Notes 

The property writing starts the measurement for the channel independently 
of the trigger initiation and trigger source settings. The function of the 
property writing waits for the completion of the measurement. 

Equivalent Softkeys 
Calibration > Response (Thru) > Thru 
 
Calibration > One Path 2–Port Cal > Thru 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel 

Object Type Property (read/write) 

Data Type String 

Target 
Calibration kit, selected for channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The calibration kit label. 

Range up to 254 characters 

Preset Value 

Varies depending on the number of the calibration kit. 

1: Not Def 50Ohm 

2: Not Def 75Ohm 

3: 05CK10A-150 –F– 

4: 05CK10A-150 –M– 

5: N1.1 Type-N –F– 

6: N1.1 Type-N –M– 

7: Agil. 85032B –F– 

8: Agil. 85032B –M– 

9: Agil. 85036B –F– 

10: Agil. 85036B –M– 

11: N611 –F– 

12: N611 –M– 

13: Empty 

14: Empty 

15: Empty 

16: Empty 

Syntax 

Dim Lab  As String 

Lab  = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel = "User1" 

Equivalent Softkeys Calibration > Edit Cal Kit > Label 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.RESet 

Object Type Method 

Target 
Calibration kit, selected for channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Resets the calibration kit to the factory settings. 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.RESet 

Equivalent Softkeys Calibration > Restore Cal Kit 

 

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect 

Object Type Property (read/write) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The selected calibration kit for the channel. 

Range from 1 to 16 

Out of Range An error occurs. Error code: 222. 

Preset Value 1 

Syntax 

Dim Value As Long 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect = 3 

Equivalent Softkeys Calibration > Cal Kit > Cal Kit n 
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Table 8. Std: Calibration Standard Number 

Data Type Long 

Description The number of the standard. 

Range Varies depending on the number of the standards in the calibration kit. 

Out of Range 
If the specified standard number is greater than the number of standards in 
the kit, an error occurs (error code: 222). 

Notes If the standard number is not specified, it is taken as equal to 1. 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C0 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The C0 value of the open calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard.  

Unit 1E–15 F (Farad) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C0 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C0 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Capacitance > C0 [10–15 F] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The C1 value of the open calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–27 F/Hz (Farad/Hertz) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Capacitance > C1 [10–27 F/Hz] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The C2 value of the open calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–36 F/Hz2 (Farad/Hertz2) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Capacitance > C2 [10–36 F/Hz2] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The C3 value of the open calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–45 F/Hz3 (Farad/Hertz3) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Capacitance > C3 [10–45 F/Hz3] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The offset delay value of the calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit s (second) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay = 93E–12 

Equivalent Softkeys Calibration > Edit Cal Kit > Offset Delay 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L0 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The L0 value of the short calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–12 H (Henry) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L0 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L0 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Inductance > L0 [10–12 H] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The L1 value of the short calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–24 H/Hz (Henry/Hertz) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Inductance > L1 [10–24 H/Hz] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L2 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The L2 value of the short calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–33 H/Hz2 (Henry/Hertz2) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L2 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L2 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Inductance > L2 [10–33 H/Hz2] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The L3 value of the short calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit 1E–42 H/Hz3 (Henry/Hertz3) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3 = 100 

Equivalent Softkeys Calibration > Edit Cal Kit > Inductance > L3 [10–42 H/Hz3] 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel 

Object Type Property (read) 

Data Type String 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The label of the calibration standard. 

Range up to 254 characters 

Preset Value Varies depending on the selected calibration kit and the standard. 

Syntax  

Dim Lab  As String 

Lab  = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel 

 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The offset loss value of the calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Varies depending on the selected calibration kit and the standard. 

Unit Ω/s (Ohm/second) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS = 700E6 

Equivalent Softkeys Calibration > Edit Cal Kit > Offset Loss 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).TYPE 

Object Type Property (read only) 

Data Type String 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The type of the calibration standard. 

Range 

"OPEN"  :  Open 

"SHORt"  :  Short 

"LOAD"  :  Load 

"THRU"  :  Thru 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Syntax  
Dim Param As String 

Param = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).TYPE 

Equivalent Softkeys Calibration > Edit Cal Kit > STD Type 
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0 

Object Type Property (read/write) 

Data Type Double 

Target 

Standard Std of the calibration kit specified for channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Std:  standard number (see Table 8 on page 191) 

Description The offset Z0 value of the calibration standard. 

Range from –1E18 to 1E18 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 50 or 75, depending on the selected calibration kit. 

Unit Ω (Ohm) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0 

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0 = 50 

Equivalent Softkeys Calibration > Edit Cal Kit > Offset Z0 
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SCPI.SENSe(Ch).CORRection.COLLect.CLEar 

Object Type Method 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Clears the measurement values of the calibration standards. 

Syntax  app.SCPI.SENSe(Ch).CORRection.COLLect.CLEar 

Equivalent Softkeys Calibration > Calibrate > Response (Open) | Response (Short) | Response 
(Thru) | One Path 2–Port Cal | Full 1–Port Cal > Cancel 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 206 

SCPI.SENSe(Ch).CORRection.COLLect.ECAL.INFormation 

Object Type Property (read only) 

Data Type String 

Target AutoCal module (Ch – arbitrary number 1 to 9) 

Description 

Gets information about the AutoCal Module connected to the Network 
Analyzer in a string with comma separated fields. 
Autocal Module Information: 

Model Name, 
Serial Number, 
Current Temperature of AutoCal Module, 

Selected Characterization Information: 
Characterization Name, 
Characterization Date and Time, 
Min Frequency, 
Max Frequency, 
Number of Points, 
Characterization Temperature, 
PortA Connector, 
PortB Connector, 
PortA Adapter, 
PortB Adapter, 
Analyzer, 
Location, 
Operator. 

Syntax  
Dim ID As String 

ID = app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.INFormation 

Equivalent Softkeys Calibration > AutoCal > Characterization Info 
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.ORIenation.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target AutoCal (Ch – arbitrary number 1 to 9) 

Description The ON/OFF state of the Auto-Orientation function used when executing 
AutoCal. 

Allowable Values 
True: Auto-Orientation function ON 
False: Auto-Orientation function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.ORIentation.STATe 

app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.ORIentation.STATe = False 

Equivalent Softkeys Calibration > AutoCal > Orientation > Auto 
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.PATH(Pt) 

Object Type Property (read/write) 

Data Type Long 

Target AutoCal (Ch – arbitrary number 1 to 9) 

Description Sets or reads out the AutoCal module port number which is connected to a 
selected Network Analyzer port (Pt). 

Allowable Values 
1: Port A of AutoCal Module 
2: Port B of AutoCal Module 

Syntax 
Dim Value As Long 
Value = app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.PATH(Pt) 
app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.PATH(Pt) = 2 

Equivalent Softkeys Calibration > AutoCal > Orientation > Port 1 - Port A | Port 1 - Port B 
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT1 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 22) 

Description Executes 1-port calibration of the specified port of selected channel (Ch) 
using the AutoCal module. 

Syntax 
Dim Port As Long 
app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT1 = Port 

Equivalent Softkeys Calibration > AutoCal > 1-Port AutoCal | 2-Port AutoCal 
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.UCHar 

Object Type Property (read/write) 

Data Type String 

Target AutoCal (Ch – arbitrary number 1 to 9) 

Description Sets or reads out the Characteristic used when executing AutoCal (factory or 
user characterization). 

Range 

"CHAR0" : Factory characterization 

"CHAR1" : User characterization 1 

"CHAR2" : User characterization 2 

"CHAR3" : User characterization 3 

Preset Value CHAR0 

Syntax 

Dim Param As String 

Param = app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.UCHar 

app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.UCHar = "CHAR0" 

Equivalent Softkeys Calibration > AutoCal > Characterization > Factory | User 1 | User 2 | User 3 
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.ERESponse 

Object Type Property (write only) 

Data Type Variant (Long array) 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Selects the ports and sets the one path 2–port calibration type for the 
calculation of the calibration coefficients on completion of the calibration 
executed by the SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. 

The array contains 2 elements: 

Data(0)  the number of the receiver port; 

Data(1)  the number of the source port. 

Range 
Port number is 1 or 2. The array elements can not contain the same port 
numbers. 

Out of Range 
If an incorrect port number is specified, an error occurs (error code: 222). If 
the same port numbers are specified, an error occurs (error code: 220). 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.ERESponse = Array(2, 1) 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.OPEN 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Selects the port and sets the response calibration (Open) type for the 
calculation of the calibration coefficients on completion of the calibration 
executed by the SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. 

Range from 1 to 2 

Out of Range An error occurs. Error code: 222. 

Syntax 
app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.OPEN = 
1 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.SHORt 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Selects the port and sets the response calibration (Short) type for the 
calculation of the calibration coefficients on completion of the calibration 
executed by the SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. 

Range from 1 to 2 

Out of Range An error occurs. Error code: 222. 

Syntax 
app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.SHORt = 
1 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.THRU 

Object Type Property (write only) 

Data Type Variant (Long array) 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Selects the ports and sets the response calibration (Thru) type for the 
calculation of the calibration coefficients on completion of the calibration 
executed by the SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. 

The array contains 2 elements: 

Data(0)     the number of the receiver port; 

        Data(1)  the number of the source port. 

Range 
Port number is 1 or 2. Array elements can not contain the same port 
numbers. 

Out of Range 
If an incorrect port number is specified, an error occurs (error code: 222). If 
the same port numbers are specified, an error occurs (error code: 220). 

Syntax 
app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.THRU = Array(2, 
1) 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT1 

Object Type Property (write only) 

Data Type Long 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Selects the port and sets the full 1–port calibration type for the calculation 
of the calibration coefficients on completion of the calibration executed by 
the SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. 

Range from 1 to 2 

Out of Range An error occurs. Error code: 222. 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT1 = 1 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.TYPE 

Object Type Property (read only) 

Data Type String 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The calibration type selected for calculating of the calibration coefficients 
on completion of the calibration executed by the 

SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. 

Range 

"RESPO"  :  Response (Open) 

"RESPS"  :  Response (Short) 

"RESPT"  :  Response (Thru) 

"SOLT1"  :  Full 1–port calibration 

"1PATH"  :  One path 2–port calibration  

"NONE"  :  Not defined 

Syntax 
Dim Param As String 

Param = app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.TYPE 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).CORRection.COLLect.SAVE 

Object Type Method 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

Calculates the calibration coefficients from the calibration standards 
measurements depending on the selected calibration type. 

On completion of the method, all the calibration standards measurements 
are cleared and the error correction automatically turns ON. 

At the attempt to execute this method before all the needed standards are 
measured, an error occurs and the method is ignored. 

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.SAVE 

Related Commands 

Calibration type selection: 

SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.OPEN 
SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.SHORt 
SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.THRU 
SCPI.SENSe(Ch).CORRection.COLLect.METHod.ERESponse 
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT1 
Calibration standards measurement: 

SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD 
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.OPEN 
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SHORt 
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.THRU  

Equivalent Softkeys 
Calibration > Response (Open) | Response (Short) | Response (Thru) | One 
Path 2–Port Cal | Full 1–Port Cal > Apply  
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls) 

Object Type Property (read/write) 

Data Type Double 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt: port number 1–2 (see Table 2 on page 21) 

Description 

The value of the frequency at the point number Ls for calculation of the loss 
for the port extension function, 

Ls: point number 1–2 (see Table 9 on page 218) 

Range from 2E4 to 4.8E9 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1e9 

Unit Hz (Hertz) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls) 

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls) = 100Е6 

Equivalent Softkeys Calibration > Port Extensions > Loss > Freq1 | Freq2 

 
 

Table 9. Ls: point number 

Data Type Long 

Description Point number for setting the losses in the functions extension of port 

Range 1 or 2 

Out of Range An error occurs. Error code: 222 
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt: port number 1–2 (see Table 2 on page 21) 

Description 

The ON/OFF state of the loss compensation at the point number Ls to calculate 
the loss for the port extension function, 

Ls: point number 1–2 (see Table 9 on page 218). 

Allowable Values 
True: Loss compensation ON 
False: Loss compensation OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe 

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe = True 

Equivalent Softkeys Calibration > Port Extensions > Loss > Loss1 | Loss2 
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC 

Object Type Property (read/write) 

Data Type Double 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt: port number 1–2 (see Table 2 on page 21) 

Description The loss value at DC for the loss calculation of the port extension function. 

Range from -200 to 200  

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit dB (decibel) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC 

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC = 10 

Equivalent Softkeys Calibration > Port Extensions > Loss > Loss at DC 
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls) 

Object Type Property (read/write) 

Data Type Double 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt: port number 1–2 (see Table 2 on page 21) 

Description 

The loss value at the point number Ls to calculate the loss for the port 
extension function, 

Ls: point number 1–2 (see Table 9 on page 218) 

Range from -200 to 200  

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit dB (decibel) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls) 

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls) = 10 

Equivalent Softkeys Calibration > Port Extensions > Loss > Loss 1 | Loss 2 
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).TIME 

Object Type Property (read/write) 

Data Type Double 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Pt: port number 1–2 (see Table 2 on page 21) 

Description The electrical delay value for the port extension function. 

Range from -10 to 10  

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).TIME 

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).TIME = 1e-9 

Equivalent Softkeys Calibration > Port Extensions > Extension Port1 | Extension Port2 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 223 

SCPI.SENSe(Ch).CORRection.EXTension.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the port extension function. 

Allowable Values 
True: Port extension function ON 
False: Port extension function OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).CORRection.EXTension.STATe 

app.SCPI.SENSe(Ch).CORRection.EXTension.STATe = True 

Equivalent Softkeys Calibration > Port Extensions > Extension 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 224 

SCPI.SENSe(Ch).CORRection.IMPedance.INPut.MAGNitude 

Object Type Property (read/write) 

Data Type Double 

Target Instrument 

Description The system impedance Z0. 

Range from 0.001 to 1000 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 50 

Unit Ω (Ohm) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe.CORRection.IMPedance.INPut.MAGNitude 

app.SCPI.SENSe.CORRection.IMPedance.INPut.MAGNitude = 75 

Equivalent Softkeys Calibration > System Z0 
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SCPI.SENSe(Ch).CORRection.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the error correction. 

Allowable Values 
True:  Error correction ON 
False: Error correction OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).CORRection.STATe 

app.SCPI.SENSe(Ch).CORRection.STATe = True 

Equivalent Softkeys Calibration > Correction 
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SCPI.SENSe(Ch).CORRection.TRANsform.TIME.FREQuency 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The Value of Frequency specified for Cable Loss in Time Domain 
measurements. 

Range from 1.0 to 10000.0 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1000.0 

Unit MHz 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.FREQuency 

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.FREQuency = 2000.0 

Equivalent Softkeys Analysis  >  Time Domain  >  Cable Correction  >  Frequency 
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SCPI.SENSe(Ch).CORRection.TRANsform.TIME.LOSS 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The Value of Cable Loss for Time Domain measurements. 

Range from 0.0 to 1000.0 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0.0 

Unit dB/m 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.LOSS 

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.LOSS = 0.25 

Equivalent Softkeys Analysis  >  Time Domain  >  Cable Correction  >  Cable Loss 
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SCPI.SENSe(Ch).CORRection.TRANsform.TIME.RVELocity 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The Value of Velocity Factor for Time Domain measurements. 

Range from 0.01 to 1.0 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 1.0 

Unit None 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.RVELocity 

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.RVELocity = 0.68 

Equivalent Softkeys Analysis  >  Time Domain  >  Cable Correction  >  Velocity Factor 
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SCPI.SENSe(Ch).CORRection.TRANsform.TIME.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
The channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of Cable Loss correction in Time Domain measurements. 

Allowable Values 
True: Cable Loss correction ON 
False: Cable Loss correction OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.STATe 

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.STATe = True 

Equivalent Softkeys Analysis  >  Time Domain  >  Cable Correction  >  Cable Correction 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 230 

SCPI.SENSe(Ch).CORRection.TYPE(Tr) 

Object Type Property (read only) 

Data Type Variant (Variant array) 

Target 

Trace Tr of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 
Tr: trace number 1–8 (see Table 3 on page 29) 

Description 

The information about the applied calibration type and the port numbers for 
the specified trace. 

The array contains 3 elements: 

Data(0) calibration type (see below); 

Data(1) the number of the receiver port to be calibrated; 

Data(2)  the number of the source port to be calibrated. 

Range 

Calibration type in the element Data(0): 

"RESPO"  :  Response (Open) 

"RESPS"  :  Response (Short) 

"RESPT"  :  Response (Thru) 

"SOLT1"  :  Full 1–port calibration 

"1PATH"  :  One path 2–port calibration  

"NONE"  :  Not defined  

Syntax 
Dim CalInfo As Variant 

CalInfo  = app.SCPI.SENSe(Ch).CORRection.TYPE(Tr) 

Equivalent Softkeys None 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 231 

SCPI.SENSe(Ch).FREQuency.CENTer 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The stimulus center value of the sweep range for linear or logarithmic sweep 
types. 

Range 
From the minimum value to the maximum value of the analyzer frequency 
range. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The center value of the analyzer frequency range. 

Unit Hz (Hertz) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).FREQuency.CENTer  

app.SCPI.SENSe(Ch).FREQuency.CENTer = 1Е9 

Equivalent Softkeys Stimulus > Center 
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SCPI.SENSe(Ch).FREQuency.CW 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The value of the fixed frequency for the power sweep. 

Before this method is called, the sweep type must be set to power sweep, 
otherwise the method is ignored. 

Range 
From the minimum value to the maximum value of the analyzer frequency 
range. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The center value of the analyzer frequency range. 

Unit Hz (Hertz) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).FREQuency.CW  

app.SCPI.SENSe(Ch).FREQuency.CW = 1Е9 

Equivalent Softkeys Stimulus > Power > CW Freq 
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SCPI.SENSe(Ch).FREQuency.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The array of the measurement points frequency for linear, logarithmic or 
segment sweep type. 

The array size is N, where N is the number of measurement points. 

For the n–th point, where n from 1 to N: 

Data(n–1)  the frequency value at the n–th measurement point. 

Syntax  
Dim Data As Variant 

Data = app. SCPI.SENSe(Ch).FREQuency.DATA 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).FREQuency.SPAN 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The stimulus span value of the sweep range for linear or logarithmic sweep 
types. 

Range From 0 to the maximum span of the analyzer frequency range. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The maximum span of the analyzer frequency range. 

Unit Hz (Hertz) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).FREQuency.SPAN  

app.SCPI.SENSe(Ch).FREQuency.SPAN = 1Е9 

Equivalent Softkeys Stimulus > Span 
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SCPI.SENSe(Ch).FREQuency.STARt 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The stimulus start value of the sweep range for linear or logarithmic sweep 
types. 

Range 
From the minimum value to the maximum value of the analyzer frequency 
range. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The minimum value of the analyzer frequency range. 

Unit Hz (Hertz) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).FREQuency.STARt  

app.SCPI.SENSe(Ch).FREQuency.STARt = 1Е6 

Equivalent Softkeys Stimulus > Start 
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SCPI.SENSe(Ch).FREQuency.STOP 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 
The stimulus stop value of the sweep range for linear or logarithmic sweep 
types. 

Range 
From the minimum value to the maximum value of the analyzer frequency 
range. 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The maximum value of the analyzer frequency range. 

Unit Hz (Hertz) 

Syntax  

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).FREQuency.STOP  

app.SCPI.SENSe(Ch).FREQuency.STOP = 1Е8 

Equivalent Softkeys Stimulus > Stop 
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SCPI.SENSe(Ch).ROSCillator.SOURce 

Object Type Property (read/write) 

Data Type String 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description Selects the internal or external source of the reference frequency of 10 MHz. 

Range 

"INTernal"  :  Internal source of the reference frequency 

"EXTernal" :  External source of the reference frequency 

Notes 

The short format of the parameter is indicated by upper case letters. There is no 
distinction between upper and lower case letters when the property is written. 
When the property is read out, the short format is indicated by upper case 
letters. 

Out of Range An error occurs. Error code: 224. 

Preset Value "INT" 

Syntax  

Dim Param As String 

Param = app.SCPI.SENSe(Ch).ROSCillator.SOURce 

app.SCPI.SENSe(Ch).ROSCillator.SOURce = "EXT" 

Equivalent Softkeys None 
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SCPI.SENSe(Ch).SEGMent.DATA 

Object Type Property (read/write) 

Data Type Variant (Double array) 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description 

The array of the segment sweep table. 

The array has the following format: 
 
{ <Buf>, <Flag1>, <Flag2>, <Flag3>, <Flag4>, <Flag5>, <N>, 
<Start(1)>, <Stop(1)>, <NOP(1)> [,<IFBW(1)>] [,<Pow(1)>] [,<Del(1)>] [,<Time(1)>],  
<Start(2)>, <Stop(2)>, <NOP(2)> [,<IFBW(2)>] [,<Pow(2)>] [,<Del(2)>] [,<Time(2)>], 

… 
<Start(N)>, <Stop(N)>, <NOP(N)> [,<IFBW(N)>] [,<Pow(N)>] [,<Del(N)>] [,<Time(N)>] } 

<Buf> : Always 5, 
<Flag1> : Stimulus start setting (0 – start/stop, 1 – center/span), 
<Flag2> : Setting of the <IFBW> field (0 – disabled, 1 – enabled), 
<Flag3> : Setting of the <Pow> field (0 – disabled, 1 – enabled), 
<Flag4> : Setting of the <Del> field (0 – disabled, 1 – enabled), 
<Flag5> : Setting of the <Time> field (0 – disabled, 1 – enabled), 
<N> : Number of segments, 
<Start n> : Start value of the n–th segment, 
<Stop n> : Stop value of the n–th segment, 
<NOP n> : Number of points of the n–th segment, 
<IFBW n> : IF bandwidth of the n–th segment (if enabled), 
<Pow n> : Power of the n–th segment (if enabled), 
<Del n>      : Measurement delay of the n–th segment (if enabled), 

<Time n> : Reserved for future use (if enabled). 

Syntax  

Dim Data As Variant 

Data = app.SCPI.SENSe(Ch).SEGMent.DATA 

app.SCPI.SENSe(Ch).SEGMent.DATA = Data 

Equivalent Softkeys Stimulus > Segment Table 
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SCPI.SENSe(Ch).SWEep.POINt.TIME 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The value of the delay before measurement in each measurement point. 

Range from 0 to 0.3 

Resolution 5E-6 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit s (second) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SENSe(Ch).SWEep.POINt.TIME 

app.SCPI.SENSe(Ch).SWEep.POINt.TIME = 5Е-6 

Equivalent Softkeys Stimulus > Meas Delay 
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SCPI.SENSe(Ch).SWEep.POINts 

Object Type Property (read/write) 

Data Type Long 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description The number of measurement points. 

Range 
from 2 to 16001 (Planar TR1300) 
from 2 to 200001 (TR5048, TR7530) 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 201 

Syntax 

Dim Value As Long 

Value = app.SCPI.SENSe(Ch).SWEep.POINts 

app.SCPI.SENSe(Ch).SWEep.POINts = 1001 

Equivalent Softkeys Stimulus > Points 
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SCPI.SENSe(Ch).SWEep.REVerse.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description The ON/OFF state of the reverse scan. 

Allowable Values 
True:  Reserse Scan ON 
False: Reverse Scan OFF 

Preset Value "False" 

Syntax  

Dim Status As Boolean 

Status = app.SCPI.SENSe(Ch).SWEep.REVerse.STATe 

app.SCPI.SENSe(Ch).SWEep.REVerse.STATe = True 

Equivalent Softkeys Stimulus  >  Sweep Type  >  Reverse Scan 
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SCPI.SENSe(Ch).SWEep.TYPE 

Object Type Property (read/write) 

Data Type String 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description Sets the sweep type. 

Range 

"LINear"  :  Linear frequency sweep   

"LOGarithmic" :  Logarithmic frequency sweep   

"SEGMent" :  Segment frequency sweep 

"POWer " :  Power sweep 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 206. 

Preset Value "LIN" 

Syntax  

Dim Param As String 

Param = app.SCPI.SENSe(Ch).SWEep.TYPE 

app.SCPI.SENSe(Ch).SWEep.TYPE = "LOG" 

Equivalent Softkeys Stimulus  > Sweep Type 
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SCPI.SERVice.CHANnel(Ch).ACTive 

Object Type Property (read only) 

Data Type Long 

Target Instrument 

Description The number of the active channel. 

Syntax  
Dim Value As Long 

Value = app.SCPI.SERVice.CHANnel(1).ACTive 

Equivalent Softkeys None 

 

SCPI.SERVice.CHANnel(Ch).COUNt 

Object Type Property (read only) 

Data Type Long 

Target Instrument 

Description The maximum number of the channels. 

Syntax  
Dim Value As Long 

Value = app.SCPI.SERVice.CHANnel(1).COUNt 

Equivalent Softkeys None 
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SCPI.SERVice.CHANnel(Ch).TRACe.ACTive 

Object Type Property (read only) 

Data Type Long 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description The active trace number of the channel. 

Syntax  
Dim Value As Long 

Value = app.SCPI.SERVice.CHANnel(Ch).TRACe.ACTive 

Equivalent Softkeys None 

 

SCPI.SERVice.CHANnel(Ch).TRACe.COUNt 

Object Type Property (read only) 

Data Type Long 

Target Instrument 

Description The maximum number of the traces in the channel. 

Syntax  
Dim Value As Long 

Value = app.SCPI.SERVice.CHANnel(1).TRACe.COUNt 

Equivalent Softkeys None 
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SCPI.SERVice.PORT.COUNt 

Object Type Property (read only) 

Data Type Long 

Target Instrument 

Description The number of the ports. 

Syntax  
Dim Value As Long 

Value = app.SCPI.SERVice.PORT.COUNt 

Equivalent Softkeys None 

 

SCPI.SERVice.SWEep.FREQency.MAXimum 

Object Type Property (read only) 

Data Type Double 

Target Instrument 

Description The upper limit of the measurement frequency. 

Syntax  
Dim Value As Double 

Value = app.SCPI.SERVice.SWEep.FREQency.MAXimum 

Equivalent Softkeys None 
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SCPI.SERVice.SWEep.FREQency.MINimum 

Object Type Property (read only) 

Data Type Double 

Target Instrument 

Description The lower limit of the measurement frequency. 

Syntax  
Dim Value As Double 

Value = app.SCPI.SERVice.SWEep.FREQency.MINimum 

Equivalent Softkeys None 

 

SCPI.SERVice.SWEep.POINts 

Object Type Property (read only) 

Data Type Double 

Target Instrument 

Description The maximum number of the measurement points. 

Syntax  
Dim Value As Long 

Value = app.SCPI.SERVice.SWEep.POINts 

Equivalent Softkeys None 
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SCPI.SOURce(Ch).POWer.CENTer 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description The center value of the power sweep range. 

Range 
From the minimum value to the maximum value of the analyzer power 
range 

Resolution 0.05 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value Center value of the analyzer power range. 

Unit dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SOURce(Ch).POWer.CENTer 

app.SCPI.SOURce(Ch).POWer.CENTer = -5 

Equivalent Softkeys Stimulus > Center 
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SCPI.SOURce(Ch).POWer.LEVel.IMMediate.AMPLitude 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

Description The power level for the frequency sweep. 

Range 
From the minimum value to the maximum value of the analyzer power 
range 

Resolution 0.05 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SOURce(Ch).POWer.LEVel.IMMediate.AMPLitude 

app.SCPI.SOURce(Ch).POWer.LEVel.IMMediate.AMPLitude = -10 

Equivalent Softkeys Stimulus > Power > Output Power 
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SCPI.SOURce(Ch).POWer.LEVel.SLOPe.DATA 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The power slope value for the frequency sweep. 

Range from 0 to 2 

Resolution 0.05 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value 0 

Unit dB/GHz (decibel/gigahertz) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SOURce(Ch).POWer.LEVel.SLOPe.DATA 

app.SCPI.SOURce(Ch).POWer.LEVel.SLOPe.DATA = 0.2 

Equivalent Softkeys Stimulus > Power > Power Slope 
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SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.DATA 

Object Type Property (read only) 

Data Type Variant (Double array) 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Pt:  port number 1–2 (see Table 2 on page 21) 

Description 

The power correction table. 

The array size is 1+2N, where N is the number of the table rows. 

For the n–th point, where n from 1 to N: 

Data(0)  the number of the table rows N integer from 0 to 
10001; 

Data(2n–1)  the frequency of the n–th row of the table; 

Data(2n)  power correction value of the n–th row of the table. 

Syntax 
Dim Data As Variant 

Data  = app.SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.DATA 

Equivalent Softkeys None 
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SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target 

Port Pt of channel Ch, 
Ch: channel number 1–9 (see Table 1 on page 21) 

           Pt:  port number 1–2 (see Table 2 on page 21) 

Description The ON/OFF state of the power correction function. 

Allowable Values 
True:  Power correction ON 
False: Power correction OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe 

app.SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe = True 

Equivalent Softkeys None 
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SCPI.SOURce(Ch).POWer.SPAN 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The power span for the power sweep. 

Range From 0 to the maximum span of the analyzer power range. 

Resolution 0.05 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The maximum span of the analyzer power range. 

Unit dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SOURce(Ch).POWer.SPAN 

app.SCPI.SOURce(Ch).POWer.SPAN = 50 

Equivalent Softkeys Stimulus > Span 
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SCPI.SOURce(Ch).POWer.STARt 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The power sweep start for the power sweep. 

Range 
From the minimum value to the maximum value of the analyzer power 
range. 

Resolution 0.05 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The minimum value of the analyzer power range. 

Unit dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SOURce(Ch).POWer.STARt 

app.SCPI.SOURce(Ch).POWer.STARt = -5 

Equivalent Softkeys Stimulus > Start 
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SCPI.SOURce(Ch).POWer.STOP 

Object Type Property (read/write) 

Data Type Double 

Target 
Channel Ch, 

Ch: channel number 1–9 (see Table 1 on page 21) 

Description The power sweep stop for the power sweep. 

Range 
From the minimum value to the maximum value of the analyzer power 
range. 

Resolution 0.05 

Out of Range Sets the value of the limit, which is closer to the specified value. 

Preset Value The maximum value of the analyzer power range. 

Unit dBm (decibels above 1 milliwatt) 

Syntax 

Dim Value As Double 

Value = app.SCPI.SOURce(Ch).POWer.STOP 

app.SCPI.SOURce(Ch).POWer.STOP = 0 

Equivalent Softkeys Stimulus > Stop 
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SCPI.SYSTem.COMMunicate.ECAL.TEMPerature.SENSor 

Object Type Property (read only) 

Data Type Double 

Target AutoCal module 

Description 
Reads out the temperature of the AutoCal module connected to the 
instrument. 

Unit °C (Celsius) 

Syntax 
Dim Value As Double 

Value = app.SCPI.SYSTem.COMMunicate.ECAL.TEMPerature.SENSor 

Equivalent Softkeys None 
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SCPI.SYSTem.CORRection.STATe 

Object Type Property (read/write) 

Data Type Boolean 

Target Instrument 

Description The ON/OFF state of the system error correction. 

Allowable Values 
True:  System error correction ON 
False: System error correction OFF 

Preset Value True 

Syntax 

Dim Status As Boolean 

Status = app.SCPI.SYSTem.CORRection.STATe 

app.SCPI.SYSTem.CORRection.STATe = False 

Equivalent Softkeys None 
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SCPI.SYSTem.DATE 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target Instrument   

Description 

The current date. 

The array consists of three elements: 

Data(0)  year from 1900 to 2100; 

Data(1)  month from 1 to 12; 

Data(2)  day from 1 to 31. 

Syntax 

Dim Data As Variant 

Data  = app.SCPI.SYSTem.DATE 

app. app.SCPI.SYSTem.DATE = Array(2009, 9, 9) 

Equivalent Softkeys None 
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SCPI.SYSTem.HIDe 

Object Type Method 

Target Instrument 

Description Make the main form of a application invisible. 

Syntax app.SCPI.SYSTem.HIDe 

Related Commands SCPI.SYSTem.SHOw 

Equivalent Softkeys None 
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SCPI.SYSTem.LOCal 

Object Type Method 

Target Instrument 

Description 
Sets the instrument to the local operation mode, when all the keys on the 
front panel, mouse and the touch screen are active. 

Syntax app.SCPI.SYSTem.LOCal 

Related Commands SCPI.SYSTem.RWLock 

Equivalent Softkeys None 
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SCPI.SYSTem.PRESet 

Object Type Method 

Target Instrument 

Description 

Resets the instrument to the factory settings. The difference from the 
SCPI.IEEE4882.RST: method is that the trigger is set to the Continuous 
trigger mode. 

Syntax app.SCPI.SYSTem.PRESet 

Equivalent Softkeys System > Preset > Apply 
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SCPI.SYSTem.REMote 

Object Type Method 

Target Instrument 

Description 

Sets the instrument to the remote operation mode, when all the keys on the 
front panel, mouse and the touch screen are not active, except for one key 
labeled Return to Local. Pushing this button will reset the instrument to the 
local operation mode. 

Syntax app. SCPI.SYSTem.REMote 

Related Commands SCPI.SYSTem.LOCal 

Equivalent Softkeys None 
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SCPI.SYSTem.RWLock 

Object Type Method 

Target Instrument 

Description 

Sets the instrument to the remote operation mode, when all the keys on the 
front panel, mouse and the touch screen are not active. Only 
SCPI.SYSTem.LOCal or SCPI.SYSTem.REMote command can release this 
remote operation mode. 

Syntax app. SCPI.SYSTem.RWLock 

Related Commands 
SCPI.SYSTem.LOCal 

SCPI.SYSTem.REMote 

Equivalent Softkeys None 
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SCPI.SYSTem.SHOw 

Object Type Method 

Target Instrument 

Description Return the main form of a application to visible state. 

Syntax app. SCPI.SYSTem.SHOw 

Related Commands SCPI.SYSTem.HIDe 

Equivalent Softkeys None 
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SCPI.SYSTem.TERMinate 

Object Type Method 

Target Instrument 

Description Close the COM server application. 

Syntax app. SCPI.SYSTem.TERMinate 

Equivalent Softkeys System  >  Exit  >  Ok 
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SCPI.SYSTem.TIME 

Object Type Property (read/write) 

Data Type Variant (Long array) 

Target Instrument   

Description 

The current time. 

The array consists of three elements: 

Data(0)  hours from 0 to 23; 

Data(1)  minutes from 0 to 59; 

Data(2)  seconds from 0 to 59. 

Syntax 

Dim Data As Variant 

Data  = app.SCPI.SYSTem.TIME 

app. app.SCPI.SYSTem.TIME = Array(15, 20, 30) 

Equivalent Softkeys None 



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 266 

SCPI.TRIGger.INPut.POLarity 

Object Type Property (read/write) 

Data Type String 

Target Instrument 

Description Selects the polarity of the external trigger. 

Range 
"POSitive" : Positive edge 
"NEGative" : Negative edge 

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 205. 

Preset Value "NEG" 

Syntax 

Dim Param As String 

Param = app.SCPI.TRIGger.INPut.POLarity 

app.SCPI.TRIGger.INPut.POLarity = "POS" 

Related Commands SCPI.TRIGger.SEQuence.SOURce 

Equivalent Softkeys Stimulus  > Trigger > Ext Trig Polarity > Negative edge | Positive edge 
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SCPI.TRIGger.SEQuence.IMMediate 

Object Type Method 

Target Instrument 

Description 

Generates a trigger, independently of the trigger source setting (except for 
the External). If the trigger source is set to External, an error occurs (error 
code 221) and the command is ignored. 

If the instrument is not in the waiting for a trigger state (sweep is in progress 
or all the channels are set to Hold), an error occurs (error code 211) and the 
command is ignored. 

The method returns control before the end of the sweep. 

Syntax app.SCPI.TRIGger.SEQuence.IMMediate 

Related Commands 
SCPI.TRIGger.SEQuence.SOURce 
SCPI.INITiate(Ch).CONTinuous  
SCPI.INITiate(Ch).IMMediate 

Equivalent Softkeys None 
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SCPI.TRIGger.SEQuence.POINt 

Object Type Property (read/write) 

Data Type Boolean 

Target Instrument 

Description 

The ON/OFF state of the point trigger feature. 

When the point trigger feature is turned ON, the external trigger response is 
single point. When the point trigger feature is turned OFF, the external 
trigger response is single sweep. 

Allowable Values 
True: point trigger feature ON 
False: point trigger feature OFF 

Preset Value False 

Syntax 

Dim Status As Boolean 
Status = app.SCPI.TRIGger.SEQuence.POINt 

app.SCPI.TRIGger.SEQuence.POINt = True 

Related Commands SCPI.TRIGger.SEQuence.SOURce 

Equivalent Softkeys Stimulus > Trigger > Ext Trig Event > On Sweep | On Point 
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SCPI.TRIGger.SEQuence.SINGle 

Object Type Method 

Target Instrument 

Description 

Generates a trigger, independently of the trigger source setting (except for 
the External). If the trigger source is set to External, an error occurs (error 
code 221) and the command is ignored. 

If the instrument is not in the waiting for a trigger state (sweep is in progress 
or all the channels are set to Hold), an error occurs (error code 211) and the 
command is ignored. 

The method does not return control before the end of the sweep (waiting for 
the completion of the sweep of all the channels). 

Syntax app.SCPI.TRIGger.SEQuence.SINGle 

Related Commands 
SCPI.TRIGger.SEQuence.SOURce 
SCPI.INITiate(Ch).CONTinuous  
SCPI.INITiate(Ch).IMMediate 

Equivalent Softkeys None 
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SCPI.TRIGger.SEQuence.SOURce 

Object Type Property (read/write) 

Data Type String 

Target Instrument 

Description Selects the sweep trigger source. 

Range 

"INTernal"  :  Internal   

"EXTernal" :  External  

"BUS"  :  Bus  

Notes 

The short format of the parameter is indicated by upper case letters. There is 
no distinction between upper and lower case letters when the property is 
written. When the property is read out, the short format is indicated by upper 
case letters. 

Out of Range An error occurs. Error code: 205. 

Preset Value "INT" 

Syntax 

Dim Param As String 

Param = app.SCPI.TRIGger.SEQuence.SOURce 

app.SCPI.TRIGger.SEQuence.SOURce = "BUS" 

Related Commands 
SCPI.TRIGger.SEQuence.IMMediate  
SCPI.TRIGger.SEQuence.SINGle  
SCPI.IEEE4882.TRG 

Equivalent Softkeys Stimulus  > Trigger > Trigger Source > Internal | External  



Planar TR1300/1, TR5048, TR7530  COM/DCOM Programming manual 

 271 

SCPI.TRIGger.SEQuence.STATe 

Object Type Property (read only) 

Data Type String 

Target Instrument 

Description Returns the status of the scanner. 

Range 

"HOLD"  :  scanning is stopped 

"WAIT" :  waiting for the start 

"MEAS"  :  is scanning 

Notes The short format of the parameter is indicated by upper case letters. 

Out of Range An error occurs. Error code: 200. 

Syntax 
Dim Param As String 

Param = app.SCPI.TRIGger.SEQuence.STATe 

Related Commands 

SCPI.TRIGger.SEQuence.IMMediate  
SCPI.TRIGger.SEQuence.SINGle  
SCPI.IEEE4882.TRG 
SCPI.IEEE4882.RST 

Equivalent Softkeys None 
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Appendix 1. Error Codes 

114 "Header suffix out of range" 

200 "Execution error" 

211 "Trigger ignored" 

213 "Init ignored" 

220 "Parameter Error" 

222 "Data out of range" 

224 "Illegal parameter value" 

201 "Invalid channel index" 

202 "Invalid trace index" 

203 "Invalid marker index" 

204 "Marker is not active" 

205 "Invalid save type specifier" 

206 "Invalid sweep type specifier" 

207 "Invalid trigger source specifier" 

208 "Invalid measurement parameter specifier" 

209 "Invalid format specifier" 

210 "Invalid data math specifier" 

214 "Invalid limit data" 

215 "Invalid segment data" 

216 "Invalid standard type specifier" 

217 "Invalid conversion specifier" 

218 "Invalid gating shape specifier" 

219 "Invalid gating type specifier" 

300 "Device-specific error" 

302 "Status reporting system error" 
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Appendix 2. Programming Examples 

 

Example 1. Instrument Information String Readout 

The following program reads out and displays on the screen the instrument information 
string – the Name property of the COM object. The string contains the following fields: 

Manufacturer, Model, Serial Number, Software Version/Firmware Version  

For example: 

Copper Mountain Technologies, TR5048, 00000001, 0.7.9/ 2.0 
 
Dim app As Object 

Sub Example1() 

Set app = CreateObject("TR5048.Application") 

ID = app.Name 

MsgBox ("Information string read out: " + ID) 

End Sub 
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Example 2. Checking the Instrument Ready State 

Normally, the user control program starts when the analyzer executable module is 
running, the instrument booting is completed, and the instrument is ready for use. In 
some cases, it is recommended to check if the instrument is ready for use. The 
instrument may be not ready for use if it is not connected to PC via USB cable. 
Moreover, if the analyzer executable module has not been started in advance, the 
CreateObject function will automatically start the application and then within about 10 
seconds the instrument booting will be in progress. The instrument will not be ready for 
use until the booting is completed. The Ready property is used to check if the 
instrument is ready for use. 

The following program checks the Ready property right after a COM object has been 
created. If the analyzer executable module has been started in advance and the booting 
is completed, “Analyzer is ready” will be displayed. If the Ready property value is 
False, 10 second delay is activated for the case the analyzer executable module has been 
started by the COM object creation. In 10 seconds the program rechecks the Ready 
property. If the value is True, “Analyzer is ready” will be displayed, if otherwise, 
“Analyzer is not ready” will be displayed, what means the instrument is not turned on 
or it is not connected to PC via USB cable. 

 
Dim app As Object 

Sub Example2() 

Set app = CreateObject("TR5048.Application") 

If app.Ready = False Then 

   Application.Wait (Now + TimeValue("0:00:10")) 

   If app.Ready = False Then 

      MsgBox ("Analyzer is not ready") 

      Exit Sub 

   End If 

End If 

MsgBox ("Analyzer is ready") 

End Sub 
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Example 3. Setting the Measurement Parameters  

The following program shows the setting of some measurement parameters. First, the 
instrument is reset to the factory settings. Then the following parameters are set: 

 Two channel windows are opened and allocated one above the other.  

 The number of traces is set to 2 in the first channel window.  

 For the first channel the stimulus parameters are set as follows: the frequency 
range from 100 MHz to 1.2 GHz, the number of measurement points 401.  

 For the second channel the stimulus parameters are set as follows: the frequency 
range from 800 MHz to 900 MHz, the number of points 51, IF bandwidth 100 Hz, 
stimulus power –10 dBm.  

 In the first channel window: S11 measurement is set for the trace 1, S21 
measurement is set for the trace 2. The Smith chart format is set for the both traces.  

 In the second channel window: S21 measurement and logarithmic magnitude 
format are set for the single trace. Then the auto scale function is called for this trace.  

 
Dim app As Object 

 

Public Sub Example3() 

Set app = CreateObject("TR5048.Application") 

 

app.SCPI.SYSTem.PRESet 

 

app.SCPI.DISPlay.Split = 2 

app.SCPI.Calculate(1).Parameter.Count = 2 

 

app.SCPI.SENSe(1).Frequency.Start = 100000000 

app.SCPI.SENSe(1).Frequency.STOP = 1200000000 

app.SCPI.SENSe(1).SWEep.Points = 401 

 

app.SCPI.SENSe(2).Frequency.Start = 800000000 

app.SCPI.SENSe(2).Frequency.STOP = 900000000 

app.SCPI.SENSe(2).SWEep.Points = 51 

app.SCPI.SENSe(2).BANDwidth.RESolution = 100 

app.SCPI.Source(2).Power.LEVel.IMMediate.AMPlitude = -10 

 

app.SCPI.Calculate(1).Parameter(1).DEFine = "S11" 

app.SCPI.Calculate(1).Parameter(2).DEFine = "S21" 

app.SCPI.Calculate(1).Parameter(1).Select 

app.SCPI.Calculate(1).Selected.Format = "SMIT" 

app.SCPI.Calculate(1).Parameter(2).Select 

app.SCPI.Calculate(1).Selected.Format = "SMIT" 
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app.SCPI.Calculate(2).Parameter(1).DEFine = "S21" 

app.SCPI.Calculate(2).Parameter(1).Select 

app.SCPI.Calculate(2).Selected.Format = "MLOG" 

app.SCPI.DISPlay.Window(2).TRACe(1).Y.SCALe.AUTO 

 

End Sub 
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Example 4. Measurement Data Acquisition 

The following program shows data array acquisition with further writing into a file. The 
program also shows the method of a sweep triggering and waiting for the sweep 
completion. 

Three variables F, M, P are declared in the second string of the code. They are used for 
arrays of frequency values (Hz), magnitude values (dB), and phase values (degree) 
respectively.  

After the instrument has been reset to the factory settings, two operators are used for the 
sweep triggering and waiting for the sweep completion: 

app.SCPI.TRIGger.SEQuence.Source = "BUS" 

app.SCPI.TRIGger.SEQuence.Single 

The first operator sets the LAN bus command or the COM/DCOM interface command 
as a trigger source. It aborts the sweep and switches the instrument to waiting for a 
trigger. The second operator is used for a new sweep triggering and waiting for the 
sweep completion. 

 

Note  Unlike the SCPI.TRIGger.SEQuence.IMMediate and  
SCPI.IEEE4882.TRG commands, which are completed 
immediately after a trigger generation, the 
SCPI.TRIGger.SEQuence.Single command is not completed 
until the end of the sweep. Using the 
SCPI.TRIGger.SEQuence.Single command is the simplest way 
to set the waiting for the sweep completion. 

On completion of the sweep, three arrays are read out: frequency values, magnitude 
values and phase values. Before the magnitude and phase arrays are read out, the 
corresponding trace format is set.  

The array size of frequency F is equal to the number of measurement points, and the 
array size of magnitude M and phase P is equal to the double number of measurement 
points (see section 11 “Measurement Data Arrays”). In rectangular formats (for 
magnitude and phase) the measurement data are real numbers located in even cells of 
the array. Odd cells of the array contain 0.  

On completion of the program, the frequency, magnitude and phase values for each 
measurement point are written string by string into the file named TESTFILE. 
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Dim app As Object 

Dim F, M, P 

 

Public Sub Example4() 

Set app = CreateObject("TR5048.Application") 

 

app.SCPI.SYSTem.PRESet 

 

app.SCPI.TRIGger.SEQuence.Source = "BUS" 

app.SCPI.TRIGger.SEQuence.Single 

 

F = app.SCPI.SENSe(1).Frequency.Data 

 

app.SCPI.Calculate(1).Selected.Format = "MLOG" 

M = app.SCPI.Calculate(1).Selected.Data.FDATa 

 

app.SCPI.Calculate(1).Selected.Format = "PHASe" 

P = app.SCPI.Calculate(1).Selected.Data.FDATa 

 

Open "TESTFILE" For Output As #1 

 

For i = LBound(F) To UBound(F) 

    Print #1, F(i), M(i * 2), P(i * 2) 

Next i 

 

Close #1 

End Sub 
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Example 5. Program Written in C++ 

The following C++ program represents an example of the measurement parameter 
setting, as well as acquisition and display of the measurement data array. The program 
also shows a method of the sweep triggering and waiting for the sweep completion.  
 
//--------------------------------------------------------------------------- 
// Simple example of using COM object of TR5048.exe application. 
// This example is console application. GUI is not used in this example to  
// simplify the program. Error proccessing is very restricted too. 
#include "stdafx.h" 
//--------------------------------------------------------------------------- 
// Generate description of COM object of TR5048.exe application.  
#import "TR5048.exe" no_namespace 
//--------------------------------------------------------------------------- 
int _tmain(int argc, _TCHAR* argv[]) 
{ 
 ITR5048Ptr pNWA;     // Pointer to COM object of TR5048.exe 
 CComVariant Data;    // Variable for measurement data 
 // Init COM subsystem 
 HRESULT hr = CoInitialize(NULL);     
 if(hr != S_OK) return -1; 
 // Create COM object 
 hr = pNWA.CreateInstance(__uuidof(TR5048));  
 if(hr != S_OK) return -1; 
 // Preset network analyzer 
 pNWA->SCPI->SYSTem->PRESet();   
 // Set frequency start to 1 GHz 
 pNWA->SCPI->SENSe[1]->FREQuency->STARt = 1e8; 
 // Set frequency stop to 1.2 GHz 
 pNWA->SCPI->SENSe[1]->FREQuency->STOP = 1.2e8; 
 // Set number of measurement points to 51 
 pNWA->SCPI->SENSe[1]->SWEep->POINts = 51;  
 // Set measured parameter to S21 
 pNWA->SCPI->CALCulate[1]->PARameter[1]->DEFine = "S21"; 
 // Set trigger source to GPIB/LAN bus or COM interface 
 pNWA->SCPI->TRIGger->SEQuence->SOURce = "bus"; 
 // Trigger measurement and wait   
 pNWA->SCPI->TRIGger->SEQuence->SINGle(); 
 // Get measurement data (array of complex numbers) 
 Data = pNWA->SCPI->CALCulate[1]->SELected->DATA->FDATa; 
 // Display measurement data. 
 // Data is array of NOP * 2 (number of measurement points).  
 // Where n is an integer between 0 and NOP - 1.  
 // Data(n*2)   : Primary value at the n-th measurement point.  
 // Data(n*2+1) : Secondary value at the n-th measurement point. Always 0  
 //       when the data format is not the Smith chart or the polar. 
 CComSafeArray<double> mSafeArray; 
 if (mSafeArray.Attach(Data.parray) == S_OK)  
 { 
  for (unsigned int n = 0; n < mSafeArray.GetCount() / 2; ++n) 
  { 
   printf("%+.9E\t%+.9E\n",  
   mSafeArray.GetAt(n*2), 
   mSafeArray.GetAt(n*2+1)); 
  } 
  mSafeArray.Detach(); 
 } 
 printf("Press ENTER to exit.\n"); 
 getc(stdin); 
 // Release COM object 
 pNWA.Release(); 
 CoUninitialize(); 
 return 0; 
} 
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